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Chapter 1

Getting Started Guide

Introducing Sage 100

Sage, the recognized leader in accounting software for small- and mid-size
businesses, welcomes you to Sage 100.

About This Guide

The Getting Started Guide is for first-time users and people upgrading from a prior
version of the product. This guide assumes you have a basic understanding of
Microsoft Windows®. Before you begin using the software, read this guide for a
general overview of system features, common procedures, and other important
information.

Some sections of this guide reference Business Insights Reporter and the eBusiness
Manager, Fixed Assets, Job Cost, Material Requirements Planning, Payroll,
TimeCard, and Work Order modules, which are not available for Sage 100 Premium.

This guide contains the following information:

e An introduction to the software, including its toolbars, views, windows, and
navigation tips

e How to get help while you work
e Hands-on lessons that demonstrate common system-wide procedures
e Troubleshooting information

Some features described here may not be available in your Sage 100 system.
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About This Guide

Graphic Conventions
The following icons are used throughout this manual to indicate different types of
information.

The Note symbol is followed by additional information about

é a topic.

- I ’fx; The HeLpruL HINT symbol is located in a grey text box and
@ followed by additional information about an option.

The WARNING symbol is followed by information to help you

A avoid costly mistakes.
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Where to Find Information

Text Conventions

The following table describes the text conventions used in this manual.

Text Convention Explanation

Menus Menus are shown in this format: Select menu >
menu task name.

Examples:

e Select File menu > Change Company.
e Select General Ledger Budget menu >
Budget Maintenance.

Bold font Indicates text entered at a field or text selected at
a field.

e Examples:

e At the Value field, type a search value, such
as 01, for the lookup.

e In the Filter window, to delete a filter, select
<none> at a filter's Column field.

Italic font Indicates references to other manuals.
Example:

e For more information about installing demo
data, refer to your Installation and System
Administrator's Guide.

Where to Find Information

Your Sage 100 system is a powerful, flexible program. The software provides
several resources to help answer your questions. Sources of documentation include
the Help system, the Installation and System Administrator's Guide, the feature
tours, and additional documents. Customer Support is available as well.

Help System

Use the Help system when you want overview information, selective procedures for
day-to-day processing, or detailed information and entry samples for a specific field.
For more information, See How to Use the Help System on page 43.
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Where to Find Information

Getting Started Guide

Installation and System Administrator's Guide

An Installation and System Administrator's Guide is included in your software
package. This guide provides the information necessary for installing the software,
detailed system requirements, and troubleshooting tips on the configuration of the
various operating systems and environments in which the software is supported. It is
designed to function as a self-teaching guide.

Customer Upgrade Guide

If you are upgrading from a previous version of the software, the Customer Upgrade
Guide is also included in your software package and provides information on the
changes to expect after upgrading to a new version of your Sage 100 system. This
guide lists changes to the software that may affect your daily business processes.
For a complete list of enhancements, see the What's New page accessible from the
Resources page of the Sage 100 Desktop. For more information, See What's New
on page 4.

Feature Tours

Use the feature tours to take a guided tour through the software and learn basic
features such as entering data and printing reports. Some tours are installed with the
software and are accessed from the Desktop's Feature Tours page. For more
information, See Viewing Feature Tours on page 48.

What's New

From the Desktop's Resources page, click What's New to learn about the latest
software enhancements. Also, on the Resources page, click Getting Started to
access this guide in an online format. For more information, See About the Desktop
Web Pages on page 32.

Additional Documents

Additional documents provided for your benefit include Release Notices, Supported
Platform Matrices, product update information, and file layout and program
information.

Use the Release Notices to learn about enhancements, features, and modifications
for each module of the software release. The Release Notices are installed with your
software. To view them, access the What's New page and click Release Notices.

For a complete list of system requirements, refer to the Supported Platform Matrix.
To access the matrix, see article ID 47649 in the Sage Knowledgebase at
support.na.sage.com.

If a product update is available for your version of the software, from the Desktop
Resources page, click Product Update to view a list of changes included in the
update.

From the Desktop's Resources page, click the File Layouts and Program Information
link to view file layout and program information.
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Where to Find Information

Customer Support

Sage Business Care Support Plans provide you with the technical expertise you
need to keep your accounting system running smoothly. For more information, call
1-866-709-2432 or e-mail us at clientcare.na@sage.com. Customer support is also
available online at: https://support.na.sage.com
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Chapter 2

é NoTE

Business Insights
Reporter and the
Fixed Assets, Job
Cost, Material
Requirements
Planning, Payroll,
TimeCard, and
Work Order
modules are not
available for
Sage 100
Premium.

Getting Started Guide

Touring the Software

This chapter is an introduction to the software, its common buttons and icons,
different views, navigation tips, and common functionality available in maintenance
and data entry windows. The screens in this chapter reflect the ABC company
demonstration data, which can be installed with your software at any time.

Getting to Know Your Desktop

The Desktop provides access to all installed modules and allows you to perform
global functions, such as selecting a company, changing a module's accounting
date, and searching for Help topics. In addition, the Desktop Web pages provide you
with important information and resources. You can customize the Desktop to fit your
needs by selecting different views, adding buttons to the Custom Buttons toolbar,
and creating private tasks. Understanding the functions of the Desktop allows you to
navigate throughout the software.

Selecting a Desktop Version

There are two versions of the Desktop, Standard and Classic. You can select the
version that you prefer on the User Settings window.

To select a Desktop version

1 On the Sage 100 File menu, select Change User Settings.
2 In the Desktop field, select either Standard or Classic.
The change will take effect when you restart Sage 100.

The following pages describe the two versions of the Desktop. Most of the
functionality is the same, but there are some features that are exclusive to each
version.

e To learn about the Standard Desktop see page 7.

e To learn about the Classic Desktop see page 16.
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Standard Desktop

Standard Desktop

This section describes the Standard Desktop. For information on the Classic
Desktop, see page 16.

A - Sage 100 M - 8 %
Home Modules View Help ~ o
B L L g o 2 @

@ F e e m = ull = | Ribbon
Change Change Change Change User Master Deferred Business Insights Launch Sage  Launch Help

Company  Date User Settings Consale Print Dashboard Fixed Assets  Sage CRM

Modules < sarcn al tesn

: ~

e Information Center

& Accounts Payable + Main

ﬁi Accounts Receivable

& Bark Recondiliation + Check Printing and Electro

i Bar Code + Pre-Note Printing Connect with Sage for tools

B il of Materias and information that help you

i Business Insights

e + Reports get the most out of

i Common Information S

. age 100.

& custom Office + Period End 9

Ei Customer Relationship Managem... + Setup

ﬁi eBusiness Manager

5| Fixed Assets + Utilities

- . | Desktop
&1 General Ledger Sage Payment Solutions browser
= + Explore Activate payment management

| Inventory Management -

@& Web Content
& Modules

W Favorites

L Content Groups

ABC Distribution anc Service Corp. (ABC)

Sage Payroll Services offers a
£

within Sage 100 to gain real-time
visibility into your cash flow and
simplify your A/R workflow.

Sage Payment Solutions

Sage Payroll Services
Now integrated with Sage 100,

Navigation pane

| Accounts Payable

Task pane

Status bar

The following is a brief description of the main parts of the Desktop. The following
pages contain more detailed information and step-by-step instructions for the key

features.

e Ribbon — The ribbon allows you to change the current company and date, log
on as a different user, start integrated products, access modules and tasks, and
customize the appearance of the program.

e Navigation Pane — The navigation pane provides another way to switch
between modules and access web content in the Desktop browser. You can also
create a Favorites list of shortcuts to Sage 100 tasks, other programs, files, and
folders.

Getting Started Guide
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Standard Desktop

Getting Started Guide

e Task Pane — The task pane displays the menus for the current module. You can
access tasks from the menus and search for tasks from the search field.

e Status Bar — The status bar displays the current company, module, user, and
accounting date for the current module. You can click in any of these areas to
change the applicable item. For example, click the current module to switch to a
different one.

e Desktop Browser — The Desktop browser displays web pages that are
installed with Sage 100, Sage CRM when started from the ribbon, and other
pages that are added to the Web Content group in the Navigation pane.

Using the Ribbon

The ribbon contains a minimum of four tabs, and you can add a Favorites tab as
well. You can minimize the ribbon so that only the tab names appear, or you can hide
it completely.

Hide Minimize

T
Sage 100 B - I:I| x
Home Modules View Help ~ o
a St ] @ i I g)
@ ﬁ i i & = il ‘.'.f
Change Change Change Change User Master Deferred Business Insights Launch Sage  Launch Help
Company  Date User Settings Console Print Dashboard Fixed Assetz  Sage CRM

Minimizing or Hiding the Ribbon

To minimize the ribbon, click the Minimize button. Only the tab names will appear.
Click the Expand button to restore the ribbon to it’s full height.

B - Sage 100 B - O x

Home Modules View Help W o

Expand

Click the Hide button to hide the ribbon. When the ribbon is hidden and you need to
view it, click in the area at the top of the Desktop to make it temporarily reappear.
Click the Hide button again to permanently unhide the ribbon.

Click in —{|
this arfea Modules < el
to unhide Information Cer

Ei Accounts Payable

(=
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Standard Desktop

Accessing Modules and Tasks

On the Modules tab, click Change Current Module to open the Change Module
window and select a module. The current module menus then appear on the right.
You will see only the modules and tasks to which you have access based on your
assigned user role.

Getting Started Guide

Sage 100
Home Modules View Help
=i @ — — — — — —
[ - | H H H H H N
Change Current  Change Secondary  Ewplore  Main  Period Reports  Setup  Utilities
Module Company - d End - - - -
Actions Accounts Receivable Clear Credit Card Informaticn

Delete and Change Customers
Global Customer Field Change
Internet Custorners Enable/Purge
Purge Accounts Receivable History
Purge Sales Tax History

Recalculate Customer High Balances
Recalculate Open Crder Amounts
Rernove Inactive Customers

Remove Temporary Customers
Remove Zero Balance Invoices

Sales Tax Calculation

il ghl ail RS0 gib RS0 giP gib oiD gib RSP 3P g5l

Salesperson Commission Purge

Changing the Font Size

On the View tab, click Application Scaling and select a font size. The text on both the
Desktop and the task windows will be resized.

Select font size Sort alphabetically
| |
=3l far * Sage 100 H - O x
Home Modules View Help -~ o
— iy | Sort module list
o 0 o A I O &
- | Sort module menus
1 | o 8= || Application =~ Navigation Status Edit Web
7| Scaling - Pane <~ Bar - Content v Sort module menu tasks
Vieual W  Default ayout Web Content Item Arrangement
Medium
Large

Alphabetizing Modules, Module Menus, and Tasks

On the View tab, in the item arrangement group, select the available check boxes to
alphabetically sort the module list, the module menus, and the tasks.
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Standard Desktop

Getting Started Guide

Adding the Favorites Tab

If you've created a Favorites list, you can access it from the ribbon by adding a
Favorites tab. Right-click any item in the ribbon, and select Show Favorites in the
Ribbon. For information on creating a Favorites list see To add a program, file, or
folder to the Favorites group on page 14

Using Key Tips
Press the ALT key to view key tips indicating which keyboard shortcut keys activate

the associated options. When the key tips are visible, press the specified key to
select an option.

Key tip
I
Sage 100 M - 8 %
I—ﬁ Moglles i \ﬁr ~ o

Change
Company Date User

Change Change Change User
Settings

Master Deferred Business Insights  Launch Sage

Launch Help
Console Print Dashboard

Fixed Assets  Sage CRM

Using the Keyboard to Access Modules

You can use keyboard shortcuts to change the current module.

To use the keyboard to change the current module

1 Press ALT.

2 Press M.

3 Press C and then H. The Change Module window opens.

4 Type the first letter of the module name to select that module. If two modules
begin with the same letter, type the letter twice. Alternately, use the Up Arrow
and Down Arrow keys to highlight a module.

5 Press Enter.
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Standard Desktop

Getting Started Guide

Using the Navigation Pane
The navigation pane allows you to change the current module, open web pages in

the Desktop browser, and create a Favorites list with shortcuts to Sage 100 tasks,
files, folders, and other software programs.

Switching Between Open and Collapsed View

You can keep the navigation pane open so that the content is always visible, or you
can use the collapsed view to save space.

When using the collapsed view, click the pane to view the content.

Open Collapesd
Click to collapse
Modules < > Click to
ﬁi Accounts Receivable - i B open
&3l Bank Reconciliation
Ei Bar Code
& Bill of Materials
Ei Business Insights 103
ﬁi Common Information '§ _I
Ei Customer Relationship Management Click and drag = Click to
i cBusiness Manoger ; to adjust width : | view
ﬁi General Ledger content
Ei Inventory Management CIICk tO
— - scroll down
=i LbraryMaster T
@ web Content Select content B
& Modules ————— group to control =1
what appears in

W Favorites ] the pane ¢

W W
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Standard Desktop

Getting Started Guide

Accessing Modules and Tasks

Use the Modules group in the navigation pane to select the current module. The task

pane is updated as you switch modules.

Click menu names to expand and collapse them, and click task names to open the

tasks.

Use the search box to search for a task. The search results include all matching
tasks for which you have the appropriate security setup, even if they are not in the

current module.

Navigation pane Task pane
rch for
Modules ¢ | Search all tasks R Sea C' 0
ataskin
ﬁi Business Insights - any module
- Budget

= )
i Common Information

=i eBusiness Manager b Automatic Budget Copy
Current L g
module ——ﬁi General Ledger ;s Budget Maintenance
ﬁi Inventory Management Budget Report
Ei Material Requirements Planning v Budget Revision Entry
Ei Paperless Office > Budget Revision Register
& Payrol
_ + Explore
= Purchase Order
& Return Merchandise Authoriza. .. - Main
ﬁi Sales Order ~
. wp Account Inquiry
& Work Order —
% Account Maintenance
; Allocation Entry
& Web Content -
+| Dailly Transaction Register

<0

& Modules

W Favorites

b gl

L4
b

General Journal
General Journal Entry
Recurring Journal

Recurrina Inurnal Fritry
-
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Standard Desktop

Viewing Web Content

When you click a link in the Web Content group, it opens in the Desktop browser.
You can add links to this group.

To add links to the Web Content group
1 On the ribbon, click the View tab.

2 Click Edit Web Content.

Add links to
Web Content
B& & -
Home Modules View Help ~ o
: - A | Sort module list
e e aa A [ = %
- - | Sort module menus
1 | [ | 5 B= || Application = Navigation Status Edit Web
7| Scaling - Pane <+ Bar - Content w| Sort module menu tasks
Wizual Layout Web Content Item Arrangement

3 Click New, and then click Link.

4 In the Link window, enter a URL and the title that you want to appear in the Web
Content group.

Link Ex
Link Editor

URL: |htip:ffwww.sage.com

Title: | Sage]

5 Click OK.
The link is added to the Web Content group of the navigation pane.

For more information about the browser, see Using the Desktop Browser on
page 15.
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Standard Desktop

Creating Favorites

You can add shortcuts to Sage 100 tasks, files, folders, other programs, and web
pages to the Favorites group.

To add a Sage 100 task to the Favorites group
There are two ways to add a task to your Favorites list:
e Drag the task from the task pane to the Favorites group.

e On the task pane, right-click a task, and then click Add to Favorites.

To add a program, file, or folder to the Favorites group

There are several ways to add a shortcut to a file, folder, or another program to your
Favorites list:

e Drag a shortcut from your Windows desktop to the Favorites group.
e Drag a program from the Windows Start menu to the Favorites group.
e Drag a file from a File Explorer window to the Favorites group.

e Right-click in the Favorites group and then click Insert Shortcut. In the Shortcut
window, browse to the item and enter a title.

Shortcut E3

Shortcut Editor

Item: |C:\Program Files (x86) Wicrosoft Office\Office 14WWINWORD,.EXE =
Title: | Word]|

To add a shortcut to a web page to the Favorites group
There are two ways to add a web page link to the Favorites group:

e In the Web Content group, start dragging a link. The link will be automatically
added to the Favorites group.

e Browse to the web page using Internet Explorer, and then drag the web page
icon from the address bar or the tab to the Favorites group.

= http://www.sage.com/us/promos/c D0 )= Sage - Software for Small &...

File Edit rag to taskbar to pin site ]—Ielp
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Standard Desktop

Using the Desktop Browser

The browser embedded in the Sage 100 Desktop is used to display web pages
accessed from the Web Content group, visual process flows, and Sage CRM when
started from the ribbon.

You can have multiple tabs open at the same time and drag the tabs to rearrange
them.

To open a tab in an external browser window, right-click the tab and then click Open
in New Window.

To go back a page, press the ALT and left arrow keys at the same time.

For more information on the web pages that are installed with Sage 100, see About
the Desktop Web Pages on page 32

Desktop browser

B&E & - Sage 100 m - O x
Home Modules View Help ~ ﬂ

Change Change Change Change User Master Deferred Business Insights Launch Sage  Launch Help
Company  Date User Settings Consale Print Dashboard Fixed Assetz  Sage CRM

> Search all tasks... L Information Center X | Resources X | Feature Tours x

+ Explore

Information Center

- Main

Cash Receipts Entry

Cash Receipts Journal

Connect with Sage for tools
and information that help you

Customer Inquiry

Customer Maintenance

get the most out of
Sage 100.

Sboaib b [SPoagh

Daily Transaction Register

Modules

Invoice Data Entry

Invoice History Inguiry

Pl gl

Invoice Printing

Repetitive Invoice Entry

Repetitive Invoice Sele...

S0 okl agld

Sales Journal

+ Period End
.Y + Reports
= + Setup

+ Utilities

Sage Payment Solutions

Activate payment management within Sage
100 to gain real-time visibility into your cash
flow and simplify your A/R workflow.

Sage Payment Solutions

Sage City
Connect with your peers and product experts
to see what others are up to.

Sage City

Accounts Receivable

Sage Payroll Services

Now integrated with Sage 100, Sage Payroll
Services offers a broad array of cloud based
payroll and HR services to power your
company’s SUccess.

Sage Payroll Services

Sage University

Learn from beginning and advanced training
offered in a variety of formats to meet your
needs.

Sage University

ABC Distribution and Service Corp. (ABC)

Getting Started Guide

jwsmith 5/31/2020
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Classic Desktop

Classic Desktop
This section describes the classic Desktop. For information on the Standard
Desktop, see page 7.

Standard Butto
Toolbar

Web
Navligation

Menu Find Tasks

Custom Buttons

Module Menus Desktop Web

d Sagel00

| e e

[ File Modules My Tasks View Hbp |

EENE 0L«

Address Bar

[EISTINIP IR

[Main Reports Peri

Q| [|x]ece |0Jounook ] customer maintenance |

L Find Task

o

Address |C:\Sage\Sage 100 Standard 2014\MASS0\auncher |rtml\welcome. html

dEnd Setup Utilities Custom Reports Explore Custom Process Flows |

Modules and Tasks §

Tasks | My Tasks

Tasks | My Tasks

== sage 100

Information Center
Resources

Feature Tours

Business Insights Dashboard
{9 Modules

EHE Private Sample 1
[E] Customer Maintznance
[E] Repetitive Invaice Selection
[E 1nvoice Data Entry
[E] cashReceipts Entry
Private Sample 2
(=) Public Sample 1
[E] Display Dashboard

[E] Report Manager
{5 Public Sample 2

[E] start Automatic Dashboard Update

bution and Servi

A veb Content |

Information Center

Connect with Sage for tools

and information that help you
get the most out of
Sage 100.

Sage Payment Solutions

Activate payment management within Sage
100 to gain real-time visibility into your cash
flow and simplify your A/R workflow.

Sage Payment Solutions

Sage City
Connect with your peers and product experts
to see what others are up to.

Sage Payroll Services

Now integrated with Sage 100, Sage Payroll
Services offers a broad array of cloud based
payroll and HR services to power your
company's success.

Sage Payroll Services
Sage University

Learn from beginning and advanced training
offered in a variety of formats to meet your

Exlt Sage 100

|ABC Distribution an JWSmith

On the Tasks tab,
select a module's
menu to display the

Tree View in the

Desktop.

é NOTE

You can undock
the Tasks and My
Tasks tabs from
the Desktop as a
stand-alone
window. For
more information,
see Changing the
Desktop's View
on page 22.

Status

Bar

needs.
S sage 100
Fie Modules MyTasks Yiew Help  © Main Reports PeriodEnd Setup Uhiities CustomReports Explore
SRR 2% @
QO MA@ Find Task & 2
Address |CiProgram 100 suncher HEmN Tutorisls.h v
— = [ Tasks | web content |
Tasks | my Tasks
Accounts Receivable - Main
Information Center Al | || @i one level...
Resources [ customer Maintenance
Foature Tours [ customer Inquiry
Business Insights Dashboard =
& Moriios Invoice History Inquiry
e ey vitar vt s nty
Commen Tnformation epettive Invoice Selection .
Pt Elirvare oatacrery Tree View
Visual Process Flows [dinvoice Printing
Paperless Office [Elsales Joumal
General Ledger [ cash Receipts Entry
1=+ Accounts Receivable [Elcash Receipts Journal
=1 Main [Elpaily Transaction Register
] Customer Maintenance
] Custemer Inquiry
[EJ nvoice History Inquiry
[ Repetitive voice Entry
[E] Repetitive Invoice Selection
[ Irvoice Data Entry
Irrvoice Printing
[ sales Journal |
[E] cash Receipts Entry
=] cash Receipts Journal
[ Daily Transaction Register
Reports
Period End
Setup
1 Utiities
(=) Custom Reports
Explors
Custom Process Flaws
Customer Relationship Managemert &
ABC Distribution and Service Corp. (ABC) Accounts Recervable Jwsmith 5/31/2010

Menu Bar — The menu bar consists of the standard menus that provide access to
module tasks and other features. You can use either the mouse or the keyboard
to select the menus. For more information, see Using the Keyboard to Access

Modules on page 31.

Toolbars — The six toolbars that appear are the Standard Buttons toolbar, Web
Navigation toolbar, Module Menus toolbar, Custom Buttons toolbar, Find Tasks

toolbar, and Address Bar toolbar. For more information about each toolbar, see
Using Toolbars on page 17.

Getting Started Guide
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Classic Desktop

é NOTE

You can hide the
Desktop Web
pages or Tree
View by clicking
the Detail View
button on the
Standard Buttons
toolbar. For more
information, see
Changing the
Desktop's View
on page 22.

Getting Started Guide

Tasks Tabs — The Tasks tabs provide a representation of the menu organization.

My Tasks Tab — The My Tasks tab allows you to add tasks and external programs
you frequently use into private task folders for quick access. For more
information, see My Tasks on page 28.

Desktop Web Pages — The Web pages available are the Information Center page,
Resources page, Feature Tours page, and Business Insights Dashboard page.
For more information, see About the Desktop Web Pages on page 32.

Tree View — On the left Tasks tab, select a module to display the Tree View. The
Tree View provides a visual representation of module menus and tasks. For
more information, see Tree View on page 27.

Status Bar — The Status Bar displays the currently selected company name and
code, active module, user logon, and the active module's accounting date. When
you select a new task from the Desktop, the Status Bar updates to reflect the
newly selected module and the module's accounting date. If you previously
accessed other modules, their existing company and accounting date do not
change. You can click the company, module, user logon, or accounting date area
on the Status Bar to make changes. For more information, see Learning
Common Procedures on page 49.

Using Toolbars

The Desktop displays six toolbars that you can optionally show or hide. To toggle
toolbars on and off, select View > Toolbars and select the toolbars to show or hide.

Click and drag the grab bar to the left of each toolbar to resize
and move the toolbars. Also, double-click the grab bar to
automatically resize the toolbar to its optimal size.

© File Modules MyTasks View Help © Main Reports PeriodEnd Setup Utiities Custom Reports Explore
= ] B 2% 7 @ |8 ¢ Elcustomer Maintenance O] oUTLOOK |§ Calculator

: @ &) | [®H| : Find Task |report manager vl 2
: Address |ﬂ Stop 3 ‘,f-')
&ll Refresh F5

» Home Cirl+Home

When you resize a toolbar, click
the More Options button to access
the hidden toolbar buttons.

All toolbars display by default and are explained in the following pages:

Module Menus Toolbar on page 18
Standard Buttons Toolbar on page 19
Custom Buttons Toolbar on page 20

Web Navigation Toolbar on page 21
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& NOTE

When the
software is first
started, the
module-specific
menus default to
the Library
Master menus.
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Find Tasks Toolbar on page 22

Address Bar Toolbar on page 22

Module Menus Toolbar

The Module Menus toolbar displays module-specific menus for the active module.
Depending on which module is active, the toolbar updates to reflect the current
module's menus.

| Main Reports Period End Setup Utilities Custom Reports Explore|

The following menus are accessible from this toolbar:

The Main menu lists the primary functions for a specific module (for example,
master file maintenance and data entry tasks).

The Reports menu lists the standard reports available for the module.

The Period End menu contains the period-end processing tasks appropriate for
the module.

The Setup menu contains the module's setup tasks and other maintenance tasks
necessary to prepare a module for normal processing.

The Utilities menu contains additional maintenance tasks for the module.

The Custom Reports menu contains default SAP® Crystal Reports® and reports
added using Report Manager and the Business Insights Reporter Wizard.

For modules with Explore Views available, the Explore menu lists the views for
the module.

In addition to these standard menus, each module may have one or more additional
menus unique to that particular module.

Page 18
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Standard Buttons Toolbar

The Standard Buttons toolbar consists of buttons used to access common tasks.

Launch Sage

Change User Deferred c Detail View
. Fixed Assets
Change Company Print Help
| | |
— i t"_"- o |
HRE LD W @
| I
Change Date Business
Master Console Insights Launch Sage CRM
Dashboard

Click the Change Company button to change companies.

Click the Change Date button to change the accounting date for the active
module.

Click the Change User button to change the user logon.

Click the Master Console button to monitor system activities. For more
information, see Master Console in the Help system.

Click the Deferred Print button to view deferred print jobs. For more information,
see Using Deferred Printing on page 67.

Click the Business Insights Dashboard button to launch Business Insights
Dashboard reports. For more information, see Dashboard Overview in the Help
system.

Click the Help button to access the Help system. For more information, see How
to Use the Help System on page 43.

Click the Detail View button to turn the Desktop's Detail View on or off. For more
information, see Detail View on page 23.
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é NOTE

The software also
provides a task to
customize your
toolbar instead of
using the drag
and drop
functionality. For
instructions, see
Opening a Task
in a Secondary
Company on
page 53.
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Custom Buttons Toolbar

The Custom Buttons toolbar is just that — customizable. You can drag and drop any
task from the Tree View onto the Custom Buttons toolbar for quick-and-easy access.
You can also drag and drop external programs and shortcuts (for example, Outlook,
Excel, or Calculator) from your desktop onto this toolbar to facilitate access to
programs you commonly use. In addition, you can rename buttons or delete them at
any time.

This task has been added to the This desktop shortcut has been
Custom Buttons toolbar. Click itto  added to the Custom Buttons
display Customer Maintenance. toolbar. Click it to start Microsoft
||
T_1 —
‘ E] Customer Maintenance J Microsoft Qutlook, = Caloulator

To add buttons

1 Use any of the following methods to add a button:
o Select View menu > Toolbars > Customize.
o Right-click any toolbar, and click Customize.

o Right-click the Custom Buttons toolbar, and select Add > Task or
Add > Program and proceed to step 3 if you are adding a task or step 4 if you
are adding an external program.

2 On the Customize Custom Buttons tab, click New Task to add a button for a
task.

Customize

| Taclbars | Custorn Butkons

M Task,.,

Show Captions Ok Cancel

3 Inthe Browse window, locate the task to add and click Open.

4 To add an external program or desktop shortcut, in the Customize window, click
New Program.

5 In the Browse window, locate the program to add and click Open.
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é NOTE

If you clear the
Show Captions
check box, the
tooltip that
appears when
your cursor
hovers over the
button identifies
it.

é NOTE

The Web
Navigation
toolbar is not
available if the
Collapsed View is
displayed. For
more information,
see Collapsed
View on page 23.
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6 To provide more space on your Custom Buttons toolbar, in the Customize
window, clear the Show Captions check box to hide the text labels and display
only icons for the buttons you added.

7 Inthe Customize window, click OK. The task and external program are added to
the Custom Buttons toolbar.

This is an example of a Custom Buttons
toolbar with text labels and icons.

- B Customer Maintenance  [5) Microsoft Outlook | F| Caloulator

This is an example of a Custom Buttons
toolbar with only icons.

L

[2EE
| - When your cursor hovers over a
| Customer Mamlenance| button, a tool tip appears to identify the

button.

To delete buttons from the Custom Buttons toolbar
1 Right-click the button to delete.

2 Click Delete.

To rename buttons on the Custom Buttons toolbar
1 Right-click the button to rename.
2 Click Rename.

3 In the Rename dialog box, type the button's new name and click OK.

Web Navigation Toolbar

Use the Web Navigation toolbar to navigate through the Web pages in the Desktop,
similar to navigating in a Web browser such as Internet Explorer.

Back Stop Home
| | |
T MR &
| |
Forward Refresh
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Find Tasks Toolbar

Use the Find Tasks toolbar to find tasks using keywords. At the Find Task field, enter
a keyword such as "accounts" and click Find. A list of all tasks related to the keyword
"accounts" displays in the Desktop.

|E Find Task v

Address Bar Toolbar

Use the Address Bar Toolbar to browse to any Web site.

: Address v f’|

Changing the Desktop's View

You can change the appearance of the software to fit your needs. The Desktop's four
basic views are:

e Detail View on page 23
e Collapsed View on page 23
e Minimized View on page 24

e Modules and Tasks View on page 25
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é NOTE

When you exit
the software, if
the Detail View
was the last view
selected, the next
time you launch
the software the
Detail View |E|
display by —
default.

When the Detail
View is displayed,
the Detail View
button is selected.

é NoTE

When you exit
the software, if
the Collapsed
View was the last
view selected,
the next time you
launch the
software the
Collapsed View
displays by
default.
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Detail View

The Detail View displays the Desktop in its full view. In this view, you have the benefit
of using the Tasks tab to navigate through the tasks and available Web pages, and
the My Tasks tab to access public and private task folders.

Use any of the following methods to display the Detail View:
e Select View menu > Detail View.
e On the Standard toolbar, click the Detail View button.

In the Detail View, you can hide the Status Bar by clearing the Status Bar selection
on the View menu. You can also hide the Tasks and My Tasks tabs by selecting View
menu > Auto Hide Tasks. To bypass the Information Center page the next time you
start the software, select View menu > Skip Information Center Page. The Tree View
appears instead.

[ sage 100 [E=8{EE 55
File Modules My Tasks View Help Main Reports Period End Setup Utilities Custom Reports Explore  Custom Process Flows.
TP eD+~%dE @ [#]exceL | O]oumock  [E] Customer Maintenance
=AZJNERHIRG Find Tack A2
Address |C:'Sage\Sage 100 Standard 2014}MAS90Y auncher )himljwelcome. html E| o
E]
Tasks | Web Content
B Sage 100 1 M
- Information Center
i-i@] Resources
{-] Feature Tours
-] Business Insights Dashboard
(-5 Modules
Connect with Sage for tools
and information that help you
get the most out of
Sage 100.
Sage Payment Solutions Sage Payroll Services L
Activate payment management within Sage Now integrated with Sage 100, Sage Payroll
100 to gain real-time visibility into your cash Services offers a broad array of cloud based
flow and simplify your A/R workflow. payroll and HR services to power your
. COMPany’s SUCCESS
Sage Payment Solutions
Sage Payroll Services
Sage City Sage University
Connect with your peers and product experts Learn from beginning and advanced training
to see what others are up to. offered in a variety of formats to meet your
. needs.
Sage City
Saae lnivarsity =]
ABC Distribution and Service Corp. (ABC) Accounts Receivable Jwsmith 10/7/2013

The Collapsed View hides the Tasks and My Tasks tabs, Desktop Web pages, Tree
View, and Web Navigation toolbar. Use this view if you prefer to use the Modules
menu to select tasks instead of the Modules tab and Tree View. This view is also
useful if you want more free space on your desktop. If the Status Bar is in view, you

can select View menu > Status Bar to hide it.
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Use any of the following methods to display the Collapsed View:
|E| e Select View menu > Detail View.

e On the Standard toolbar, click the Detail View button.

S Sage 100

: File Modules My Tasks Wiew Help © Main Reports Setup  Utilties

ERR L% O =

QO |HR| % Find Task. | 3| 2

: Address ‘C:\Prugram Files\sage'Jage 100 WorkStationMAS30Launcher\Htmlywebres. htm vl P
ABC Distribution and Service Corp. (ABC) Library Master jwsmith Sf31/2010

If you click the Business Insights Dashboard button in the Collapsed View, the
Business Insights Dashboard page displays in your default Web browser, such as
Internet Explorer.

& Note Minimized View

Select View

menu > Start The Minimized View allows you to minimize the Desktop, yet still have access to
Minimized to set most of the software's functionality. To view the Desktop in its minimized state,
uzvtﬂgﬂzeed minimize the Desktop and right-click the software icon in the system tray. In the
default view Minimized View, you can change the company, accounting date, and user, and
when starting the access modules and tasks.

software.

software icon

Libraty Masker 4
Business Insights 4
General Ledger 4
fccounts Receivable 4
Accounts Pavable 4
Change Companyy (ABX)
Payroll 4
Change Date (5f31/2010)
Inventory Management  * h Liser (i ithy
ange User (jwsmi
Sales Order 4 ? !
Purchase Order L4
My Tasks 4
Exit

:'.'-' start S [ S Sage 100
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When you exit
the software, if
the Modules and
Tasks View was
the last view
selected, the next
time you launch
the software the
Modules and
Tasks View will
display by
default.
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Modules and Tasks View

The Modules and Tasks View allows you to undock the Tasks and My Tasks tabs
from the Desktop as a stand-alone window. To view the Modules and Tasks View,
position your pointer over the Tasks and My Tasks panel, and click and drag the
panel to undock it from the Desktop. You can also double-click the Tasks and My
Tasks panel title bar to undock the Tasks and My Tasks tabs from the Desktop. For
more information, see the Customizing the Desktop tour available on the Desktop
Feature Tours page.

When the Tasks and My Tasks tabs are undocked as a stand-alone window, you can
move the window anywhere on the screen and resize it. The Modules and Tasks
View provides access to any module and task on the Tasks tab and any task stored
on the My Tasks tab without having the full Desktop displayed.

To r-attach the Tasks and My

Tasks | My Tasks Tasks tabs to the Desktop,
double-click this title bar. The
Desktop must be in Detail View.

=-{F= Private Sample 1
[E] customer Maintenance
[E] Repetitive Invoice Selection
[E] invoice Data Entry
[E] cash Receipts Entry
- Private Sample 2
== Public Sample 1
[E] isplay Dashboard
[E] start Automatic Dashboard Update
[E] report Manager
#- Public Sample 2

Exit Sage 100

ABC Distribution ani

JIWiSmith

Accessing Modules and Tasks

The software provides several ways to access modules and tasks. You can access
modules from the:

e Modules Menu on page 26

e Module Menus Toolbar on page 26
e System Tray on page 27

e Tree View on page 27

e My Tasks on page 28

e Find Tasks Toolbar on page 30

e Using the Keyboard to Access Modules on page 31
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Modules Menu

The Modules menu allows you to select any of the tasks that are installed on your
system. You can use your mouse to select tasks from the Modules menu, or you can
use the keyboard to select the Modules menu by pressing ALT+O, and typing the
underscored letter of the module and task to access.

S Sage 100

 pie [y vy Tasks view el

this task, see =" Switch To...
Chang|ng the L) | Library Master
Module on 1 Common Information

For information on

ABC Dis{ Business Insights

page 53.

Paperless Office

General Ledger
The current
module is
indicated by a
check mark next
to the module
name.

Accounts Payable
Payroll

Inventory Management
Sales Order

Purchase Order

Return Merchandise Authorization

Job Cost

Bill of Materials
Work Order

Bank Recondiliation

Electronic Reporting

v Accounts Receivable m El Customer Maintenance

Main Reports PeriodEnd Setup Utiities Custom Reports Explore

[E] customer Maintenance [O] OUTLOOK & Caleulator

o)
~| 2

1590V auncher thimlthome. htm|

o

Accounts Receivable jwsmith 5/31/2010

Reports 3 E] Customer Inquiry

Period End * [E] Invoice History Inquiry
Setup ¥ [E] Repetitive Invoice Entry
Utilities r E| Repetitive Invoice Selection
Explare 4 Invoice Printing

[E sales Jounal

[ Cash Receipts Entry

[E cashReceipts Journal
E| Daily Transaction Register

Module Menus Toolbar

The Module Menus toolbar displays module-specific menus and tasks for the active
module while the Modules menu is a cascading menu that displays menus and tasks
for all modules. From any menu, select a task.

S Sage 100

i Fle Modules MyTasks View Help

Q@K

EEE @2 %% @ TE customeMantnance

Find Task |: B customer Inquiry L‘\

: Address |C:\Program Files\sage\Sage 100 [E] tnvoice History Inguiry

:mgapuns PeriodEnd Setup Utilies Custom Reports  Explore

PUTLDDK & Calalator

¥ &

The current

ABC Distribution and Serv

Accounts Recei

[E] Repetitive Invoice Entry SEIE

module appears

Invoice Selection

| E] Invoice Data Entry

on the Status
Bar.

Getting Started Guide

(3 Invoice Printing

=] Ssales Journal

[E] Cash Receipts Entry

=] Cash Receipts Journal
[&] Daily Transaction Register
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System Tray

é NOTE

For more
information about
the Minimized

View, see
Minimized View software
on page 24.
Library Master 4
Business Insights 4
General Ledger 4
[ Aged Invoice Report Open Ttem Cust Main [ Zccounts Re 4
E Customer Sales Analysis Re b N
porks Accounts Payable
E Salesperson Commission Report Petiod End v | Payral » change Company (ABX)
; Change Date (5/31/2010)
Setup ¥ | Inventory Management * h T swsmith
E Customer Listing Sales Order » ange User (jwstith)
Purchase Order 4
My Tasks 4
Exit

's start

7 & | S sage 100

When the Desktop is minimized, you can right-click the software icon in the Windows
system tray to access tasks.

& NoTE

When you use
the Tree View,
the active module
is not changed
until you select a
task in another
module.

You can expand
or collapse each
branch of the
menu structure to
show as much, or
as little, detail as
you want.

Tree View

S Sage 100

File Modules My Tasks View Help
EE D% W @[k :

e RA & Ptk M| P

The Tree View provides another alternative for selecting tasks by visually
representing the menu organization in a tree-like structure in the Desktop. On the
Tasks tab, select a module to display the Tree View.

i Main Reports PeriodEnd Setup Utiities Custom Reports Explore

Address | CiProgram 100 auncheriHtm Tutorials. b

— 2 Tasks” | web Content
Tasks | My Tasks

Accaunts Receivable - Main

Irformation Center A | #5up one level
:es?urces [Elcistamer Mantenance
eature Tours [E customer Inuiry
Business Insights Dashboard Elltnweics History Tnquiry
=) Modules
(=] [Elrepetitive Invaice Entry

Library Master
Common Information
{3 Business Insights
Visual Process Flows
Paperless Office
{3 General Ledger

=10 Accounts Receivable
=75 Main

[Elrepetitive 1nvaice Selectior
[Eltrwvaice Data Entry
[Hirvaice Printing

[Flsales tournal

[Elcash Receipts Entry
[Hlcash Receipts Joumal
[Elpaily Transaction Register

Click a task to
access it, or
right-click a task

[E] Customer Maintenance

[E] customer Inquiry

[E] trwvaice History Inquiry

[E] Repetitive Invoice Entry
[E] repetitive Invoice Selection
[E] Irwvaice Data Entry

[ Invaice Printing

[= sales Journal

[E] Cash Receipts Entry

toopenitina
secondary
company.

Getting Started Guide

[E] cash Receipts Journal
[= aily Transaction Register
Reports
{0 Period End
Setup
Uilities
{71 Custom Reports
Explore
Custom Process Flows
{3 Customer Relationship Management v

This is the Tree View. The Tree
View shows the tasks available
from the menu selected on the
Tasks tab. To access a task,
click it. You can also right-click
any task to openitin a
secondary company. For more
information, see Opening a Task
in a Secondary Company on
page 53.

|ABC Cistribution and Service Corp, (ABC)

Accounts Receivable

jwsmith 5/31/2010
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é NOTE

For instructions
on how to
customize

My Tasks, see
Opening a Task
in a Secondary
Company on
page 53.

My Tasks

You can also access tasks by adding them to the My Tasks tab. The My Tasks tab is
an area where frequently-used tasks, such as inquiry programs, desktop shortcuts,

and external programs can be added to public or private task folders and stored for
quick access. Instead of accessing commonly-used tasks from the Modules menu or
leaving the software to start another program such as Microsoft Word, you can add

the window or program to a task folder and click the task to launch it.

Public task folders, indicated by the green plus sign, are available to all users and
are stored on the server.

Select the My
Tasks menu to
select a task and
display the same
public and private
task folders that
appear on the My
Tasks tab.

The green plus
sign marks public
task folders. Click
a public or private
task folder to
display its
contents, and
click a task to
open it.

Getting Started Guide

S Sage 100

Yiew Help

L

Main Reports PeriodEnd Setup  Utilties Custom Reports  Explore

ld E] Display Dashboard

QUTLOOK & Caloulator

H @ (5] |ﬂ Public Sample 2 ¥| ] Start Automatic Dashboard Update v ;3

: Address |CiProy Private Sampls 1 ¥ [E] Report Mariager it "l o
Privats Samplsz | @ _CsUator

[ Tasks | My Task r

Private Sample 1
Private Sample 2
(=5 Public Sample 1
[E] visplay Dashboard
[E]] Start Automatic Dashboard Update

Report Manager
£ Caloulator

{53 Public Sample 2

Sage 100 ERP
& ]Irformation Center

ERescurces

& Featurs Tours
] Business Insights Dashboard

[EModules

—— You can drag and drop tasks into
task folders. You can also drag
and drop shortcuts and programs
from your desktop into task
folders.

ABC Distribution and Service Carp. (ABC)

Accounts Receivable jusmith 5/31)2010
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Private Tasks

Private task folders are available to individual users and can only be accessed on
the workstation from which they are created. Private task folders allow individual
users to customize their own tasks on their workstation.

To create private tasks

1

Right-click in the My Tasks tab area, and select New > Private Folder.

S Sage 100

| File Modules MyTasks WView Help | Main Re
B 9L % | @| s H
2<1>JIERERE iFndTask|

! Address |C:'\Program Files\sage\Sage 100

E
Tasks | My Tasks |

Private Folde

Ed]

Type a name for the new private task folder.

Right-click the folder, and select New > Task to add a task.

In the Browse window, select the task to add and click Open.

Right-click the folder, and select New > Program to add an external program.

In the Browse window, locate and select the external program to add and click
Open.

Repeat steps 3-6 to add additional tasks or external programs.

Access the private task folder from the My Tasks tab or the My Tasks menu.

S Sage 100

. File Modules My Tasks View Help I Main Re
T BERE L% @ 1| H
0 BRER @ Find Task

: Address |C:\Program Files\sage\Sage 100

2l

ks | My Tasks
Task folder Qs My Tt |

name

-
[EL] customer Maintenance
[EX] Repetitive Invoice Selection
B tnvoice Dats Entry
[EX] cash Receipts Entry
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Type a keyword
and then click the
Lookup button. Tasks | My Tasks
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To create private tasks using the drag and drop method

1

In the Desktop's Tree View, click the task to add to the private task folder and
hold down your left mouse button.

Drag the task from the Tree View to the private task folder on the My Tasks tab.

When the private task folder is highlighted, release the left mouse button to drop
the task into the folder.

From your computer desktop, click the shortcut (for example, Word, Excel, or
SAP Crystal Reports) to add to the private task folder and hold down your left
mouse button.

Drag the desktop shortcut to the private task folder on the My Tasks tab.

When the private task folder is highlighted, release the left mouse button to drop
the desktop shortcut into the folder.

Find Tasks Toolbar

The Find Tasks toolbar allows you to find tasks using keywords. At the Find Task
field, enter a keyword such as "invoice" and click the Lookup button. A list of all tasks
related to the keyword "invoice" appears in the Desktop. You can then click a task
from the list to access it.

S Sage 100 g@E|

 Flle Modules My Tasks View Help Main Reports Period End  Setup  Utiities  Custom Reports  Explare

P E P2 T @ T ¢ Elcustome Mantensnce [ oUTLOOK |§ Caleulator

< IS ME RE R ¢ Find Task [Involce v 2

¢ Address |C\Program Files\Sage|Sage 100 WorkStationiMAs90iLauncheriHtmlwebres, him v @

2 [asks | web content

Task Hoduls Location A
= = Sage 100 [Elinvoice History L., eBusiness Mana... Inguiries
] Information Center [Eltnwoice History L. Bar Code Inuiries
] Resources [F30b Trwoice Printing  Job Cast Job Billng

@'] Feature Tours
€] Business Insights Dashboard
Hodules

[Elcreate customer... ReturnMercha,..  LUtilities
Elinvaice History L..  Return Mercha...  Inquiries
[Elreceipt of Invaic... Purchase Order  Main

[ shipping History .. Sales Order Explore
Eltnvaice History L. Sales Order Inquiries
[ nvaice Printing Sales Order Shipping
Auto Generate In... Sales Order Main
Invo\ce Printing Sales Order Main
Iﬂ[nvo\ce Data Enkry  Sales Order Main

Vendor Repetitiv... Accounts Payable  Explore
[EEvendor Open Inv... Accounts Payable  Explare
[EEvendor Histary In... Accounts Payable  Explare
[Elremave Zera Bal...  Accounts Payable  Utilities
[Flaccounts Payabl.,  Accounts Payable  Reports
[Fopen Invoice by ... Accounts Paysble  Reports
[Eaccounts Payabl... Accounts Paysble  Reports
[Eltnwoice Payment ... Accounts Payable  Check Printing and ...,
[Elinvoice Register ~ Accounts Payable  Main
[Elinvaice Data Entry  Accounts Payable  Main
[Elrepetitive Invaic... Accounts Payable  Main
[Elrepetitive Invaic... Accounts Payable  Main
Fltnunice Wisterw T deeointe Pawshle  Main
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Using the Keyboard to Access Modules

You can use your mouse to display a menu from the menu bar or Module Menus
toolbar, or you can use any of the following alternative keyboard methods:

e Use the ALT key plus the underscored letter of the menu: To directly select a
menu. For example, to select the Main menu, press ALT+M.

e Use the arrow keys: To select a menu to the right of the one presently selected,
press the RIGHT ARROW key. Each stroke of the key moves the selection one
step to the right. To move to the left, press the LEFT ARROW key. As a different
menu is selected, the menu title is highlighted to distinguish it from the other
menus.

When the appropriate menu appears, select the task to access by using the
following method:

e Use the arrow keys: Use the UP ARROW and DOWN ARROW keys to highlight
the desired task. When the menu first appears, the first task is highlighted. After
you highlight a task, you can access that task by pressing ENTER.
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About the Desktop Web Pages

The Desktop Web pages available are the Information Center page, Resources
page, Feature Tours page, and Business Insights Dashboard page. To display a web
page, select the page from the Web Content area (standard Desktop) or the Tasks
tab (classic Desktop).

B&E & -
Home Modules View

@ E AL X
i, i,
Change

Company Date User Settings

+ Explore

'
=
=
=

Cash Receipts Entry
Cash Receipts Journal
Customer Inguiry
Customer Maintenance

Daily Transaction Register

Modules

Invoice Data Entry

Inveice History Inquiry

Poagh onb [SP ofb o5b [SF o500

Inveice Printing
Repetitive Invoice Entry

Repetitive Invoice Sele...

SPoosh oib

Sales Journal

+ Period End
& + Reports

=1 + Setup

+ Utilities

ABC Distribution and Service Corp. (ABC)

Change Change Change User
Console  Print

Sage 100

ﬁ = ol ;g =

Master Deferred Business Insights Launch Sage  Launch
Fixed Assets  Sage CRM

Dashboard

Information Center

Connect with Sage for tools
and information that help you

get the most out of
Sage 100.

Sage Payment Solutions

Activate payment management within Sage
100 to gain real-time visibility into your cash
flow and simplify your A/R workflow.

Sage Payment Solutions

Sage City
Connect with your peers and product experts
to see what others are up to.

Sage City

e

Help

Sage Payroll Services

Now integrated with Sage 100, Sage Payroll
Services offers a broad array of cloud based
payroll and HR services to power your
Company’s success

Sage Payroll Services

Sage University

Learn from beginning and advanced training
offered in a variety of formats to meet your
needs.

Sage University

‘ Accounts Receivable

Information Center Page
From the Information Center page, you can find information about integrated solutions and
Sage training and support. There is also a Feedback Site link; click the link to provide your
ideas and feedback directly to Sage.

Getting Started Guide

| jwsmith

| s/31/2020
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Modules

CERE
Home

Q ST .
at B &
Change Change Change
Company Date User
> Search all tasks.. |2
+ Explore
+ Main
+ Period End
+ Reports
3
5 + Setup
o
o]
= .
+ Utilities
@
=1
*
v

bution and Sel

Sage 100
View Help
= h &
‘.- D{.} = | I
Change User Master Deferred Business Insights  Launch Sage
Settings Console Print Dashboard
Resources

The resources below offer
helpful information about

Sage 100.

Help Center

Learn detailed information about using Sage 100.

Help Center

Featured topics
The following Help Center topics cover some
frequently asked questions

Setup tasks
+ Set up ACH Electronic Payments
= Set up Paperless Office
= Set up Credit Card Processing

Coamman toaclo

@
2 @
Launch Help

Fixed Assets  Sage CRM

What's new

Read about the latest enhancements in Sage 100.

What's New

Getting Started Guide
Use this guide to familiarize yourself with the
product and learn about commen procedures.

Getting Started Guide

Upgrade Guide
Refer to this guide for information on the changes
made in recent versions of Saae 100.

Getting Started Guide

Resources Page

From the Resources page, you can access the What's New page to learn about the latest
software enhancements, view this Getting Started Guide, the Customer Upgrade Guide,
and module overview documents, access the product’s Help system, and view file layout

and program information.
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BEE & -
Home Modules
] der .
w A
Change Change Change
Company Date User
> ch all tasks.. |2
+ Explore
+ Main
+ Period End
+ Reports
i}
S + Setup
o
o]
=
+ Utilities
a
*
v

Sage 100
Wiew Help
9 1} I
- [J = alt
Change User Master Deferred Business Insights  Launch Sage
Settings Console Print Dashboard

Feature Tours

Watch feature tours to learn
about the latest and most

useful features in Sage 100.

The feature tours that are listed by name are installed with the product and require the latest Adobe Flash Player. The
links with the globe next to them will take you to a website with additional tours. An Internet connection is required to

access the website.

Feature Highlights
Check out the latest and most useful features in
Sage 100.

Watch tours &
Introduction to Sage 100

Learn about basic concepts and features and how
to access other resources

Navigating the Desktop 2:25

T
=
Launch Help

Fixed Assets Sage CRM

Sage Intelligence Reporting

See how to use this Excel add-in, which is ideal
for financial reporting and product and sales
analysis.

Watch tours &

Business Insights Explorer

Leamn how to access and maodify data-centric
views into your business. These tours
demonstrate using the drag-and-drop, sor, filter,

and othor faotucan bo acanin ad hoo E.

Getting Started Guide

Feature Tours Page

From the Feature Tours page, you can watch videos that demonstrate how to perform
various Sage 100 tasks such as entering data, using the inquiry features, and creating
custom reports. The page also includes a series of tours on Business Insights Explorer.
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BEE & -
Home Modules
@ ﬁ L)
Change Change Change
Company Date User

3 | Searchal tasks |P
+ Dashboard
+ Explorer

+ Reporter

Modules

<

Sage 100
View Help
C T& i O
"~ & = ull “as
Change User Master Deferred Business Insights Launch Sage  Launch Help
Settings Console Print Dashboard Fixed Assets  Sage CRM
Information Center X | Business Insights Dashboard 3 | Business Insights Dashboard X

ABC

Distribution and Service Corporation

Leverage Ratios

As of May 31, 2020 ||
Modify this Page

1.0 0.50
0.45
v 0.40
08 035 1
0.30
07 025
0.20
0.6 015
05 oo H
- - 0.06
0.4 0.00 — f—
Equity Debt Debt to Equity Income: Profit Expenses Return
B Pericd to Date B Period to Date m
[ Pricr Period [ Prier Period
‘Year to Date
Period to
Date, Prior Period Period to Prior| Year to
Equity Ratio 0.50 0.55 Date’ Period' Date
Debt Ratio 0.50 0.45 Net Income to Sales 0.00 0.17 0.08
Naht tn Canitv Ratin 1nn na Pracc Deafit ko Calas n 27 n A noan Sl

L

Getting Started Guide

Business Insights Dashboard Page
The Business Insights Dashboard page provides a customizable graphical summary of your

company'’s financial data.
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Becoming Familiar with Maintenance and Data Entry Windows

é NOTE

The task
windows
appearance will
vary depending
on which theme
is selected in
Company
Maintenance, but
the functionality
is the same.
The examples in
this section use
the Classic
theme.

Becoming Familiar with Maintenance and Data Entry

Windows

Throughout the software, maintenance and data entry windows share a common set
of controls which make learning the software quick and easy. Before you begin
entering data and performing common tasks, let's look at examples of these

windows.

Sample Maintenance and Data Entry Window

This sample window shows common data entry features shared by maintenance and
data entry windows. Some features may not appear in all windows.

Select the tabs at
the top of the
window to switch — |
tabs of data.

Click the
Calendar button
to access the
Calendar window
and select a date

The window's title bar

displays the current company

and accounting date.

Invoice Mumnber

+—— 1 Header W 2. Lines l

Customer Mo,

01-ABF

Custorner PO

5/3172010
643072010

Irevoice Date

Due Date

S AR Invoice Data Entry (ABC) 5/31/2010

4 b ME

3 Totals 1 4 Credit Card 1

QB

Temns Code

Ship Method

last, and prior
records.

Batch | 00001

[ American Business Futures

01 [@, Net30Days
UPS BLUE

Selects first, next,

Click this button
to view more

I information.

Click the Lookup
button to display
a list of available
items for a field.
For more

information, See

a

Using the

Diceaunt-Dat s S b 0100 [@ Jim Kertley Lookup Feature
to return to this Net [nvoice Amt Carmment
field. - Click the Print
Select a check chedule [ |G Pt lrverice: button to print
box to respond Mierkee e the report
"yes." Clear a as;oc,ated with
check box to E-mail artie@abf. com this window.
respond "no."
Click the Help
Click the Office @ — ._chﬁ/’;ef;rs g
Merge button to related
igﬁsztgﬁ":e Click Accept when all Click Cancel to Click procedures.
Manager or information is correct and remove the Delete to .
you are finished with the information entered.  delete the To resize the

Custom Office.

Getting Started Guide

current record.

record.

window, click here,
hold down your left
mouse button, and
drag the window.
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é NoTE

For more

information about

personalizing
grids, see the
Entering Data
tour available on
the Desktop
Feature Tours

page.

é NoTE

For more

information about

the right-click
menus, see the
Feature Tours
available on the
Desktop Feature

Tours page or the

Help menu.

Sample Accounts Receivable Line Entry Window

This sample Accounts Receivable Lines tab window shows common grid entry
features shared by data entry windows in modules other than Job Cost, Material

Requirements Planning, Payroll, TimeCard, and Work Order.

In addition to the features illustrated below, you can personalize a data entry grid to

allow for fast and efficient entry of data. Most columns in a grid can be moved,
resized, or hidden. You can also freeze a column of data so that a particular column
remains in view during scrolling. You can resize the data entry window, and the
Primary and Secondary grids as well. All personalizations to grids are saved for your

future data entry sessions.

To locate a
specific row, type
the number of the

row to view at this Click the
field. Click the g Calculator
[P T -PAVPINTONAEONN S /1 Invoice Data Entry (ABC) 5/31/2010 (B[=)Ed] button to
use the Search Invaice Mumber M 4 B B [Z] Batch | 00003 access the
id wi Calculator
Grid window for LHeader | Zlies | 3Tows | 4 CredtCad | i q
entering criteria to | — window an
find rows that Quick Row Ell:) EREER] calculate a
contain specific | . . value to return
) i tem Code Guantity Price Amount Comment to thlS fleld
information. 1 WIDGET 1.000 55.250 55.25 o
2 200Da 1.000 90.000 88.00 Buttons in grids
o B =7 1000 i 5 | 22000 do not appear
This is the +|C Y ol until focus is on
Primary grid. It 5 M i m the field
contains the main £ o il
data entry fields.
IES >
- Description | 19" Gadget with wWheels ~
This is the . 1| | GLAccount |400-01-00
Secondary grid. It o 75,000
contains TawClass | TX <
information for the | —
. Net| 363.25
row selected in the = Reset
Primary grid. Row and
ese
Delete Row Rows
Insert Row EREES -
Move Row Up Move Row Down

Another feature of data entry windows in modules other than Job Cost, Material

Requirements Planning, Payroll, TimeCard, and Work Order is the right-click menu.

e You can right-click outside of a grid to access system information and other

tasks.

e You can also right-click any field in a grid to access additional tasks related to the

field.

Getting Started Guide
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S| A/R Invoice Data Entry (ABC) 5/31/2010

44 b #E

2 Totals ] 4 Credit Card ]

Buick Fow

Batch

Inveice Mumber [FTO0053TT |
1Headsr | 2 Lines }
Item Code
1 WIDGET
2 | 200-DA
| B
4 |C
5 M
[
£
Description | 19" Gaday
GL Account | 4000701
Cost
Tax Class TH

Getting Started Guide

Quantity

1.000
1.000
1.000
.0oo

Price

55.250
88.000
220.000

.ooo

S 4/R Invoice Data Entry (4BC) 5/31/2010

Invoice Number l:l

4 kb E

System Infa
Panel Settings *
Related Tasks ¥

5525
88.00
220,00
00

Batch

Comment

Right-click outside of a grid to
access these options. Click
System Info to view information
such as the current user. Click
Panel Settings to launch the
Customizer module if it is installed
or to click Reset Form to reset the
form back to its default settings.
Click Related Tasks to select and
navigate to a listed task.

1 Header | 2Lines ] 3 Totals | 4 CrecktCard |
uick Row 1 = ==
= L e . ER-ER Right-click any
Item Code Quantity Pm:?. J Amaunt Comment field inside a
I - 0cET 1000 ) FROENLE 55,25 .
-0 o 2ystemInfo o grid to access
3 |ze7Ga 1.000 Banel Settings * | oo tasks and
1 c 000 Belsted Taks  * i options related
5 M 000 Hide Column 00 to the field.
5 i Shaw Calumn oL
=
F3 {EMoze Riow Diowr | 3
@Lnsert Row
Descripion | 8" # 10" Wwidgets 552 Delete Row
GL Account | 400-01-00 %Rgset Row
Cost 27.500 Reset All Rows
Tax Class = Find
Switch Grid
Freeze Column Het Inwoice
?‘(Ewurt to Excel
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The data entry
section is used to
enter and edit

data for each line.—

The list box is
used to display

Sample Work Order Line Entry Window

This sample Work Order Entry window shows common line entry features shared by
data entry windows in the Job Cost, Material Requirements Planning, Payroll, and
Work Order modules.

S Work Order Entry glil@
Wiork Order Number 0095013 |G

1. Header ] 2. Additional ] 3 Operations ] 4. Materials ] 5. Scheduling ]
tem Mumber Fievision Step Sorap % whse Click OK to
BOARD-04230 a, oo (@ 000 |00 Q~| accept the data
Drescription 1 LM Qty/Parent Estended Oty 0k .

EACH | @ 1.00 700 [ o | for a line.
Desciiption 2 Cost CostType  Procurement Type Undo
FIFO Make .
| Click Undo to

Line_ltern Nuribier Revision Step _Scrap % whse  Dty/Parent Extended cancel Changes

1 BOARD-04230 000 0000 000 [{lil] 1.00 7.00 |

2 CPUBE-29088-16 aoao .oog aog 1.00 7.00 fOr a line.

and select
entries.

Click Ins to insert
a new line.

é NOTE

The M/d/yyyy
format is the
default date
display format.
The format of the
date is set from
the Windows
Control Panel.

Getting Started Guide

—(oe][oe)
a (e [B]0)
WS | K B431/2010
L Click Del to The Accept, Cancel, Delete,
delete a line. Print, and Browse buttons

function the same way,

Understanding Basic Types of Data

During data entry, you may need to enter the following basic types of data.

Text

Unformatted entries of alphabetical information (for example, names, addresses,
and comments) are text entries.

Dates

Enter a two-digit month (MM), followed by a two-digit day (DD), followed by either a
two-digit (YY) or four-digit year (YYYY). Six or eight characters can be entered for
the date. If a two-digit year is entered, the century is determined by the century
preferences setting in the Windows Control Panel.

You do not need to put a hyphen (-) or slash (/) between the day, month, and year;
punctuation is inserted automatically. For example, to enter May 31, 2010 at a data
field, type 053110. (Do not forget the leading zero.)

Page 39



Becoming Familiar with Maintenance and Data Entry Windows

Getting Started Guide

Numeric Data

Empty numeric fields (zero value) display a mask indicating the number of digits that
can be entered to the right of the decimal point. For example, .00 appears if the
numeric field accepts two-decimal precision.

Some numeric fields (for example, quantity and hour fields) do not assume the
decimal point.

To enter negative numbers, type the negative sign (-) as either the first or the last
character of the entry.

Account Numbers

General ledger account numbers are structured fields consisting of one or more
segments separated by a hyphen (-) or other separator selected at the Account
Number Separator field in Account Structure Maintenance.

You can enter the value for each segment separated by a hyphen (-). You can also
zero, or blank fill, each segment to its maximum number of characters without using
the hyphen (-).

Example: An account field with a mask of #HHHH#H-#H-HHHE-HH#-#HE processes your
entry in the following manner.

Your Entry... Displays As...

1-2-4-6-800 00001-02-004-006-800
1234567891234567 12345-67-891-234-567
010005 01000-05-000-000-000

Page 40



Becoming Familiar with Maintenance and Data Entry Windows

Q) (¥
& NOTE

The title of the
lookup window
reflects the name
of the field at
which you clicked
the Lookup
button.

Getting Started Guide

Column headings — & WendorMo. | Wendor Name Irwoice No. | Invoice Date | Due Date Disc. Date | PastDisc. Invoice Amount Co @
O1-AIRWAY  Ainway Property 000oi0e020 - 541572010 5/30/2010 1.750.00
Click anywhere b 0-AIRWAY  Ainway Property 0000106145 541772010 5/30/2010 1.600.00 ]
\ 01-CONT Container Corporati.. 44-4567 842010 5/30/2010 80.332.89
within the line 02-4MEX American Express . MAYSTMT  B/1/2010 5/30/2010 3.000.00

select it.

Sorting and Selecting Dialog Box Data

You can sort data in columns in ascending or descending order by clicking the
column heading. Click a column heading to sort the data in reverse order. Resize the
column headings by clicking and dragging between the columns.

Dialog Box Example

S Select Invoices for Payment g@@l

0Z2EMPLOY  Employment Devel... 33-65667 542010 B/30/2010 1698211

Total Selectzd o0
(= ol

You can use the UP ARROW and DOWN ARROW keys to select line items. To
select more than one line item, press the CTRL key and click the items. To select a
range of items, press the SHIFT key, click the first item, and then click the last item in
the range.

Using the Lookup Feature

When entering data in a maintenance or data entry window, you can click the
Lookup button at certain fields to display a list of records. You can then select the
appropriate record. The Lookup feature contains options that allow you to filter and
customize the search criteria, and create up to 99 custom lookup views. In addition,
you can print the list of records appearing in the lookup list box. The illustration
below shows a lookup window.

To learn basic features of the Lookup, See Using the Lookup's Basic Features on

page 54. For instructions on how to use advanced features of the Lookup, See
Using the Lookup's Advanced Features on page 58.

Page 41



Becoming Familiar with Maintenance and Data Entry Windows

i S Vendor List
Click a column

heading to sort the Phone Mumber 1 Click this button to
list by that criteria. s prey-fr sl il drill down to
Anarmow nextto | I L Fenee Dren amion o Customer, Vendor,
the heading m-STEY Stevens Supply 95052 408) 5556781 STEVENS or ltem Inquiry.
indicates the TAPS Linien ol Sere s s This button is
current sort order. available only in
the Customer, Item,
or Vendor lookup
window.
< ¥
If filters are already T For some lookups,
defined, the text on Search  [vendar No v ||Begins with  ~| |01 press the F3 and
this button is red. —f—{ Fites | View [Standad v F4 keys to toggle
: between the key
5 field and the Name
After the search____l—————b field.
is complete, the
record count This field appears only if you Click this button to
appears in the defined one or more custom export data in the lookup
Status Bar. lookup views. The Standard window to Excel.
view is generated by the
software.

S Lookup Yendor List

If you click Print while
the Lookup list box is still
loading, only the data
that has loaded prints on
the I|St|ng Laser Printer Print [ Printer Setup. @

LOOKUPYENDOR LIST

-+~ What if you clicked the Lookup button and no records appear in the lookup
- window? This occurs because:

» The number of records is over the limit set at the Lookup Limit for Initial Display field in
User Maintenance.

» The Initial Display check box on the fifth User Lookup Wizard page is cleared. For more
information, see User Lookup Wizard in the Help system.

< A custom filter that has no result set is in effect.

To display records, filter the information by using the Search, Operand, and Value fields,
and then click Find.

Navigating with Common Buttons, Icons, and Keystrokes

All maintenance and data entry windows share the same set of buttons and
keystrokes to help you navigate through data and perform common tasks. If you
prefer to use the keyboard while you work, most buttons have keyboard equivalents.

For a list of common buttons and their keyboard shortcuts, see the Keyboard and
Button Navigation article in the Sage 100 help.
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Getting Help While You Work

Several sources of information are available to you in the software. Use the following

resources to find answers to your questions as you work.

(SEED)
File Medules My Tasks View Help Mzin Reports Budget PeriodEnd Setup Utilities Custom Reports Payroll Services Explore Custom Process
ZPEE L% u eE

[<I5)IERElR?) Find Task =] 2

Address |C:\Sage \Sage 100 Standard 2016MASS0\Launcher tmi{Tutorials.htm

]

=7 Sage 100
Information Center
Resources
Business Insghts Dashboard
5 Modules

Web Content

Feature Tours

Watch feature tours to learn
about the latest and most
useful features in Sage 100.

The feature tours that are listed by name are installed with the product and require the latest
Adobe Flash Player. The links with the giobe next to them will take you to a website with
additional tours. An Internet connection is required fo access the website.

Feature Highlights Sage Intelligence Reporting

|American Business Expressions (ABX) General Ledger Jwsmith 5/31/2020

-
Show Back Prnt

<F <«

Show Back  Prnt

Feature Tours - A Tour
of Sage 100 and the
Business Insights
Explorer

Take quick tours through
a variety of features.
These tours are available
on the Desktop Feature
Tours page.

>View All Subcategories

Show/Hide All

Overview information for that category.

Sage 100 Desktop and  * Job Cost
User Interface

To create a reversing journal entry

1. Select General Ledger Main menu > General

FAQs & Troubleshooting

Click a link below to view FAQs and troubleshooting

Accounting Dates and  * Joumals and Registers

Joumal Entry Periods

2. In the Source Journal field, enter a source ' Budgets " Paperless Office
journal code. For more information, see General * Business Insights ¥ Payroll
Jourmnal Entry - Fields * Business Objects * Posting and Updates
3. In the Entry Number field, enter the number that Interface .
identifies this journal. * Checks * Printing

Cradit Cord Tranesrd tinne

¥ Duirrbnen Do

Help System - Common Procedures Help System - FAQs & Troubleshooting
Quickly find procedures and answers for Find answers to frequently asked

your questions and view troubleshooting

"how do I" questions by selecting Help information.

menu > Help Topics.

How to Use the Help System

Use the Help system when you want procedures for day-to-day processing, detailed
information and entry samples for fields, and FAQ and troubleshooting information.

Overview information and flowcharts illustrating complex concepts are also available
in Help. If you do not find what you need, access information from the additional

resources provided on the Help menu.
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Accessing Help

You can access Help using any of the following methods:

e From the Desktop, select Help > Help Topics.

e Press F1 at any field in the software to access Help for that field.

e On the Standard Buttons toolbar, click the Help button to access global Help

topics.

e In the bottom-right corner of any window, click the Help button. Help for the

specific window appears.

e If you click the Help button and the window has corresponding How Do |

procedures, a drop-down list of procedures appears. The following illustration

shows the Help button clicked in the General Journal Entry window.

Create a General Journal Entry
Reverse & Journal Entry
Create a Standard Journal
Modify a Standard Journal
Copy & Standard Journal
Perform a Manual Allocation

Procedures commonly

performed in this window
|_appear on this list. Click a

procedure to view it.

About this Window 1

Click here to view overview
information for the window.
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Using the Help System

After you access the Help system, the following tools help you to locate information:

e Using the Contents Tab on page 45

e Using the Index Tab on page 46

Using the Contents Tab

Use the Contents tab to access the table of contents for the Help system. The
following illustration explains the common features of the Contents tab.

Whenyou —
first access
Help, the
Contents tab
is hidden.
Click Show to
use the
Contents tab.

|E§5) Help Center

d@i@

Back Print Sage

(=[O sl

Sage 100 Help System

@ Help Center

H & & [

The Help system's Home
page displays links to
frequently asked
questions, information on
using the Help system,
and a list of other
resources to help you find
answers to questions
about Sage products.

[E= [EEE

The Contents
tab displays
Help topics
organized by

Hide Back FPrint Sage
l Contents |Igdax I §earch|
@ Bar Code -
& Bill of Materials
.- Business Insights Explorer
.. Business Insights
@ Commaon Information
@ Credit Card Processing il
.- Customer Relationship Management
.. Customizer
.. eBusiness Manager
@ Fixed Assets
{7 General Ledger
- Getting Started with General Ledger

m

key subjects. - --Q[ngorking with....
- Accounts
Fgr gxample,_ I Rocatins)
C||Ck|n9 WOFklng Create and Maintain Allocations
with disp|ays Copy an Allocation
d . [2] Perfarm a Manual Allocation

proceaures - Budgets
organized by -4 Fiscal Years
subject such as - General Journal Entries

’ - Memos

Allocations or
Budgets.

Getting Started Guide

- Recurring Journal Entries
- Standard Journal Entries =

Resources

FAQs
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é NOTE

When you first

access the Help
system, the Index

tab is hidden.

Click Show to use

the Index tab.

Getting Started Guide

Using the Index Tab

Use the Index tab to search for specific words or phrases. Each Help topic has
keywords associated with it. You can search for a topic in the Index by entering
keywords. The following illustration explains the common features of the Index tab.

Type the first
few letters of
the subject for
which you are
searching. If
the topic you
are searching
for is not
indexed, the
closest word
appears in the
list box. You
can access
index entries
for all modules
on the Index
tab.

@HelpCenlel
& & (9

Hide Back Prnt Sage

=e s

Contents  Index | Search |
Type in the keyword to find

Sage 100 Help System

— |a|\uc|

freight cost to asset tem
landed and freight costs

tips
Allocation Drill Down
fields
overview
Allocation Entry
fields
overview
Allocation Joumal
fields
overview
Allocation Listing
fields
overview
Allocation Selection
fields
overview
Allocation Selection Settings
fields
overview
allocations
copying
creating

hhhhhh

allocate. -

freight costs to inventory without landed c:l:/

Resources

FAQs

Select a topic, and then click Display to view
the topic. Or, double-click a topic from the list
box to view it.
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About Customer Support

Understanding a Help Topic

A Help topic may contain procedural information, overview information, or
information about a particular feature.

Click FAQs &
Troubleshooting
to view frequently
asked questions
grouped in
common
categories, such

(% Help Center

FH = & [

Sh... Back Print Sage

Create and Maintain Allocations

Home | EAQs & Troubleshooting

m

Show/Hide All

as Budgets or
Reports.

This section lists

Overiew
Before You Begin

||'o create and maintain allocations

1. Select General Ledger Main menu > Allocation Entry.

items that must be
accomplished

before performing
this procedure, or
special conditions
that may affect the

2. Enter the allocation number. For more information,
see Allocation Entry - Fields.

3. To copy an existing allocation entry and then make
any necessary modifications, click Co

For more

— Click the +/- graphic at
this link to expand or
collapse all dynamic
drop-down links in this
topic.

information, see Copy an Allocation.

4. Enter the description for the allocation
enter the Source Account field for the g

@ Help Center

@ e &

5. Inthe Allocation Method field, select th| SN Badk Prit Sage

=8 Eol =)

result of this
procedure.

Getting Started Guide

method to use for the allocation.

6. If you are creating a basis allocation, in

At the end of some
procedures, examples
are provided that
illustrate concepts or B
tasks from the procedure.
Click the +/- graphic to
expand or collapse the
example.

14. Towview the information entered for accuracy, click the
Print button and print the Allocation Listing. For more
information, see Allocation Listing. Click Accept.

An allocation entry is created or modified. You can post
manual allocations using General Journal Entry. and post
cycle allocations using Allocation Selection.

Example - Planning Allocations

Example - Creating Quantity Allocations

Example - Creating Percent Allocations

The following Allocation Journal shows how the allocation
amount is distributed using the Percent method.

Allocation Source Amount: $550.00

Account Description %
No.

50500- Copier 30%
01-010- Expense:lnvine—

000-000 Admin

50500- Copier 25%
01-020- Expense:lnine—

000-000 Sales

T

m

Dis
An
1

3

About Customer Support

There are several resources you can use for technical assistance before contacting
your Sage business partner or Customer Support:

e Refer to the software's Help system.

e For a complete list of system requirements, refer to the Supported Platform
Matrix. To access the matrix, see article ID 47649 in the Sage Knowledgebase at

support.na.sage.com.
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Viewing Feature Tours

e If you need access to file layout and program information, click the File Layouts
and Program Information link on the Desktop's Resources page.

e Attempt to duplicate the issue in one of the sample companies provided with your
software. This will help a technician identify the problem and speed up the

process of obtaining a resolution.

After using the above options, if you require more assistance, select Help menu >
Customer Support for information on how to contact Sage Customer Support.

Viewing Feature Tours

On the Desktop Tutorials page, click one of the feature tour links to become familiar
with basic concepts and features, such as navigating the software, customizing your
Desktop, and learn how to use Business Insights Explorer. These feature tours are a
multimedia introduction to the software. You can also access additional feature tours

on the Web.
[ sage100 [E=8 EER
File Modules My Tasks View Help Dashboard Reporter Explorer
ZPE @LL % @[k Eowm 0omook E]custme Mantenance
QO XN G Find Task =] 2
Address C:\Sage\Sage 100 Standard 2014YMAS80\auncher htmi\Tutorils.htm E\ e
k|
Tasks | Web Content
Tasks | My Tasks == -
- Sage 100 A -
) Information Center Introduction to Sage 100
€] Resources
Learn about basic concepts and features and how to
€
@] Business Insights Dashboard access olher resources
15 Modules Navigating the Desktop 2:25 f
= Library Master TO beglnr
=1 Common Information Customizing the Desktop 1:34 CliCk a tour.
{51 sage Intelligence Reporting L
-5 Business Insights 7 Entering Data 3:21
{5 visual Process Flows
{5 Paperless Office Working with Memos 1:09 L
) General Ledger = =
{51 Accounts Receivable Leary 205100 Pepenouen ==
=1 Customer Relationship Management
=1 Accounts Payable Using
{51 Payroll L
=1 Inventory Management Printi
{5 Sales Order
{51 Purchase Order Creat|
{5 Return Merchandise Authorization
{51 Job Cost Discq
= Bill of Materials
=i A age

ABC Distribution and Service Corp. (ABC)

Use the Back and Rewind

buttons or drag the progress
marker to navigate through the |
feature tour. Click the Rewind

button to return to the first page

of the tour.

|emeea;

Navigating the Standard Desktop
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é NoTE

The Job Cost,
Material
Requirements

Planning, Payroll,

TimeCard, and
Work Order
modules are not
available for
Sage 100
Premium.
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Learning Common Procedures

Whether you are new to Sage 100, or an experienced user who wants to review
basic and advanced concepts, this chapter gives you hands-on practice with
common procedures. Some lessons apply only to the standard Desktop and some to
the classic Desktop; they are organized accordingly.

Lessons
This chapter contains the following lessons:

e Creating a Company on page 50

e Creating a User on page 51

e Changing a User Password on page 52

e Changing User Settings on page 52

e Changing the Accounting Date on page 52

e Changing the Module on page 53

e Opening a Task in a Secondary Company on page 53
e Using the Lookup's Basic Features on page 54

e Using the Lookup's Advanced Features on page 58

e Printing Reports, Listings, or Forms on page 64

e Defining Formats for Standard Reports on page 73

e Customizing Forms on page 77

e Creating a Report Setting on page 85

e Setting Up Sage Intelligence Reporting on page 87

e Understanding How Sales Tax is Calculated on page 95

e Changing Sales Tax Information on page 102
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Creating a Company

Creating a Company

Many systems are set up with multiple companies to keep financial records for
individual companies separate, and to separate real company data from test
company data. Each company is identified by a unique, three-character company
code. You can process information for a specific company by selecting the

appropriate company code.

To create a company

1 Select Library Master Main menu > Company Maintenance.

2 Enter a company code and company name.

S Company Maintenance (4BC) 5/3142010 E@@

Campany Infarmation
Address ESE1 Irvine Center Drive
Irvinz, CA 92656

URL Address
E-mail Address

Trade Mame

Activated Modules

M odule:

Accounts Papable
Accounts Receivable
Bank Recaonciliation
Common Information
General Ledger
Inventary Management
eBusiness Manager
Purchase Order

Payroll

Fietum Merchandise Authorization
Sales Oider

Company Code 4 4 & @

Company Mame | ABC Distiibution and Service Corp.

1. Main }gPrelerences] 3 CredtCords| 4 Emsl | 5 Fax

Telephone
Fax

Federal ID Mo,
State I No.

©

[]

1

[349) 555-5000
[349) 555753

Data Level
500
500
5.00
5.00
500
5.00
5.00
500
500
5.00
5.00

[ Accept I Cancel ] Delete

3 Enterinformation in the fields appropriate to your company, including the federal

ID number.

4 Click Activate to activate one or more modules.

5 When prompted to save the new company, click Yes.

6 When the Activate Module window appears, select the module(s) to activate

and click Proceed.

7 In Company Maintenance, verify that the modules you selected appear in the
Activated Modules area of the window and click Accept.

Getting Started Guide
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Creating a User
You must enter a valid user logon and type a password, if applicable, before you can

access the software.

To create a user

1 Select Library Master Main menu > User Maintenance.

2 Enter the user logon, first and last name, and user code.

S User Maintenance {#BC) 5/31/2010

User Logon | jwsmith

First Mame  John

E-mail john.smith{@abc.com

4 kM

Last Name  Srith

Password Confirm Password

b

1 Maintenance w 2 Preferences 1 3 Auto-Complete 1

Bename.

User Code  Jw/'S

Customization Group Expires

Job Title Accountart/Boskkeeper/Cletk

Company
1 All Companies
2

Rols

{ Supervisar

Start Date Expiration Date 53
-

[T UserAccount Locked

I Accept I LCancel l Delete m

If the Use Unified Logon check box is selected in System Configuration, the
user logon must match the user’s Windows logon key field.

3 Type a password if necessary.

A password is required if the Require all Users to Enter a Password check box is

selected in System Configuration.

4 On the Maintenance tab, select the company and role to assign to the user.

5 On the Preferences tab, select user-specific preferences.

6 If the Auto-complete feature is enabled in System Configuration, change the
default options on the Auto-Complete tab as needed.

7 Click Accept.

Getting Started Guide

Page 51



Changing a User Password

é NOTE

The M/dlyyyy
format is the
default date
display format.
The format of the
accounting date
is set from the
Windows Control
Panel.
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Changing a User Password
User passwords can be changed for any user currently logged onto the system.

To change a user password

1 Select File menu > Change User Password.

2 Inthe Old Password field, type the current password for the user.
3 Inthe New Password field, type the new password for the user.

4 In the Confirm Password field, type the same password that was typed in the
New Password field.

5 Click OK.

Changing User Settings

The User Settings window allows you to specify default options, such as the default
zoom level when viewing reports.

To change user settings
1 Use any of the following methods to open the User Settings window.
o Select File menu > Change User Settings.

o When using the Standard Desktop, on the Home tab, click Change User
Settings.

o When using the Classic Desktop, on the Standard Buttons toolbar, click the
Change User Settings button.

2 Make changes as needed.

3 Click Accept.

Changing the Accounting Date

The accounting date is printed on all reports, and represents the date to be used
while posting transactions for the current module. The Library Master accounting
date is set from the Windows system date and cannot be changed.

To change the accounting date

1 Use any of the following methods to change the accounting date from the
Desktop:

o Select File menu > Change Date.

o On the Status Bar, click in the accounting date area.

Page 52



Changing the Module

é NOTE

Modules
automatically
change when you
select a task from
another module
using the Module
Menus toolbar,
Tree View, or
Modules menu.

é NoTE

To define a new
secondary
company without
opening a task,
select Change
Secondary
Company from
the right-click
menu.

Getting Started Guide

2 Enter the accounting date.

3 Click OK. The accounting date appears on the Status Bar.

Changing the Module

The active module always displays on the Status Bar.

To change the module
1 Use either of the following methods to change the module from the Desktop:
o On the Status Bar, click the module.

o When using the standard Desktop, on the Modules tab, click Change Current
Module.

o When using the classic Desktop, select Modules menu > Switch To.

2 Select a module.

3 Click OK. The new module displays on the Status Bar and the module menus
change to reflect the specified module.

Opening a Task in a Secondary Company

From the Desktop, you can open a task in a secondary company without changing
the current company displayed on the Desktop Status Bar. You can define any
company as the secondary company.

To open a task in a secondary company

1 In the Desktop's task pane (for the standard Desktop) or Tree View (for the
classic Desktop), right-click a task and select one of the following options:

o Open in New Secondary Company: Select this option to define a new
secondary company and to open the task in that secondary company, and
then proceed to step 2.

o Open in Secondary Company (ABC): Select this option to open the task in
the currently defined secondary company. In this example, the secondary
company defined is ABC, and the task opens in company ABC. You are
finished.
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Using the Lookup's Basic Features

S Sage 100

 File Modules My Tasks View Help

Q0O KR @

 Main Reports Period End Setup  Utiities Custom Reports  Explore

T HRE QL% e |E‘ . [E] Customer Maintenance [~ OUTLOOK 5 Calculator

: Find Task | - &

: Address |C:\Prngram FilesiSagelSage 100 WaorksStation\MAS0\LauncheriHEmi Tutorials. hkm

v o

Tasks ‘ My Tasks

2 Tasks | web content

General Ledger - Reports

= Modules
i) Library Master
Carmrnon Information
{1 Business Insights
{1 wWisual Process Flows
Papetless Office
=1 @eneral Ledger

Period End
=0 Setup
=0 Utilities
Custorn Reports
{0 Payroll Services
Explore
{E0 Custom Process Flows
{1 Accounts Receivable

{1 Accounts Payable
=1 Payral

Customer Relationship Management

™ E Up one level,..

Echart of Accounts

EGeneral Ledger Worksheet
EGeneral Ledger Trial Balance
EFlnanclal Reports

EGeneral Ledger Detail Report
EGeneral Ledger Detail by Source Report
EExceptlon Report

EReprlnt Journals

ESource Journal Hiskory Report
EGeneral Ledger Graphics

EGeneral Ledger Analysis

EBudget and Histary Repart
EBudget and Histary Repart by Period
Enccount Audit Report

Enccount Mermno Printing

Main Account Memo Prinking

w

ABC Diskribution and Service Corp, (AE

Accounts Receivable jrwsmith 513172010

2 Select the company to open the task in.

3 Click OK. The task opens in the selected secondary company.

Using the Lookup's Basic Features

When entering data in certain fields in a maintenance or data entry window, you can
click the Lookup button to display a list of valid records. This lesson contains basic
procedures on how to use the Lookup feature. To learn more advanced features,
See Using the Lookup's Advanced Features on page 58.

Using the Lookup to Select a Record

Use the Lookup feature to display a list of records and select the appropriate record.

Getting Started Guide
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Using the Lookup's Basic Features

To select a record using the lookup window

1 In awindow, click a Lookup button. The lookup window appears displaying the
available records.

S Vendor List

2

i =
01-ALLCLIM [714] 5551013 ALLCLIMATE
01-AMDERS  Anders Auto Repair 92969 [714) 555-3030 ANDERS
01-COMPAD Compagq Computer Corporation 92626 [714) 555-9521 COMPAD
01-CONT Container Corporation OF Lz E5436 [312) 555-7F1
01-/EM |brn Corporation 92775 [415) 555-9351 IEM
01-POSTMST U5, Postmaster 92626 [714) 555-7659 USPOST
01-50CALGA  Southem California Gas Co. 9171 [714] 565-0032 GASCO
01-5TEV Stevens Supply 95052 [408) 555-6781 STEVENS
01-UNITED Urited Computers 75285 UNITED
01-UPs Urited Past Office Service 92711 UPs
0Z-AIRTRAN Airport Service Travel 92680 AIRPORT
02-AMER&LR  American Alarm Service 46222 [B17] 555-5561 AMERICANAL
02-AME= American Express Company TH3E3 [B00) 5556675 AMEX
02-ARR 0 Anmowesraith Drinking ‘w/ ater 8a072 12131 555-5541 ARROWSMITEY
< >
Search | Wendor No w | | Beging with v

(e [ oes [R]B0)
Found 29 records

In the lookup window, select a record from the list box and click Select. The
record is then selected in the original window.

Searching in the Lookup

The lookup window provides a Search field and a Find button to narrow your search
for desired records. This feature is a convenient way to reduce the number of
records displayed and helps you to focus on pertinent records.

To search in the lookup window

1 In the lookup window, in the Search field, select the field to search.

2 Inthe Operand field, select an operand. For information about available
operands, see Filter the Lookup Criteria in the Help system.

3 Inthe Value field, type a search value for the lookup.

4 Click Find to execute the search. The lookup list box displays the search results.

Getting Started Guide

In this example, the lookup searches and returns all vendor numbers that begin
with 01.
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Using the Lookup's Basic Features

S| Vendor List g@]@'

Wendor Mo
(74
(O1-ALLCLIM

Zip Code:

Aray Property

Allclimate Maintenance

2626

Phane Murnber
01 [/14] 555-0980
[714] 5551013

Sort Field

ALLCLIMATE

i

01-4MNDERS Anders Suto Repair 92969 [#74)555-3030 ANDERS
01-COMPAQ Compagq Computer Corporation 92626 [714) 555-9521 COMPAD
01-CONT Container Corporation OF Lz E5436 [312) 555-7F1
01-1BM Ibm Corporation 92775 [415] 555-3331 IEM
01-POSTMST U5, Postmaster 92626 [#14)555-7659 UsPOsT
01-50CALGA  Southem Califomia Gas Co. 77 [714] 555-0038 GASCO
01-5TEV Stevens Supply 95052 [408) 5556781 STEVENS
01-UNITED Urited Computers 7H2E5 UNITED
01-ups United Post Office Service 9271 upPs
For instructions on 4 5
this button, See
Filtering the Search | Yendor No w | |Beging with | |01
Lookup Criteria on —|
page 56.
(o | oot [RIB])
Found 11 records
—Operand L Value field

5 Select an item from the list box and click Select. The selected record is copied
to the field.

Filtering the Lookup Criteria

In any lookup window you can define additional criteria to filter the lookup and you
can save these filters so that they apply to future lookups until they are manually
removed. Filtering the lookup criteria helps you narrow your search on desired fields.

-+~ There are two differences between filtering the lookup criteria and searching in the
- lookup. When filtering, you can define an unlimited number of filters on multiple
lookup fields, and you can save these filters so that they always apply to the
lookup. In contrast, when you perform a search in the lookup window, you can search on
only one lookup field, and the search criteria cannot be saved.

Getting Started Guide
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& NoTE

Filters that are
defined in the
User Lookup
Wizard and
Lookup
Customization
Wizard also
appear in this
window. If the
filter is locked, it
cannot be
changed. If the
filter is not
locked, it can be
removed or
modified.

é NOTE

If the Save Filters
check box is
cleared, the filters
remain in the
Filters window
and remain in
effect during the
lookup; however,
when you exit the
lookup, these
filters are
removed.
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1

To filter the lookup criteria

In the lookup window, click Filters. In the Filters window, each line item is a filter
consisting of a Column, Operand, and Value.

S Filters Q@@
’.Cu\umn Operand Walue
1 - -
2 - -
Save Filters []
(& =0

In the Column field, select the lookup column you want to filter. The Column field
reflects all of the columns defined for the lookup.

In the Operand field, select the appropriate operand. For information about
available operands, see Filter the Lookup Criteria in the Help system.

In the Value field, type a value. If you enter multiple values separated by
commas (,), the system assumes an "OR" condition.

To add additional filters, repeat steps 2 through 4. You can define an unlimited
number of filters; multiple filters assume an "AND" condition.

To retain these filters for future lookups, select the Save Filters check box.

Click OK to apply the filters. In this example, the lookup returns all vendors
beginning with 01 and ZIP Codes beginning with 7 or 9.

S Vendor List g@JEl

Airway Property %
Allcimate Maintenance -
Anders Auto Repair [714] 555-3030
01-COMPAD Campanq Computer Corparation [714] 555-9921
01-IBM |bm Carparation [415] 555-9381
O01-POSTMST LS. Pastmaster [714] 555-7659
01-50CALGA  Southern Califomia Gas Co. [714] 555-0033
01-5TEY Stevens Supply [408] 555-6781
O1-UNITED United Computers
m-ups United Post Office Service
< »
Search  [vendor No v |[Begins with % [01
(ot [ o JRIB]O)
Found 10 records
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Using the Lookup's Advanced Features

é NOTE

Clicking Reset
also clears the
Save Filters
check box.

& NOTE

If another user is
in the User
Lookup Wizard
and is creating or
modifying a
lookup code
while you attempt
to create or
modify a lookup
view, a message
appears and
prevents you
both from
continuing.

é NOTE

The Custom
button is not
available if the
Locked
Customization
check box is
selected in the
User Lookup
Wizard.
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Deleting Filters

You can delete filters after they have been defined.

To delete and reset filters
1 In the lookup window, click Filters.
2 To delete afilter, in the Filters window, select <none> in the filter's Column field.

3 To delete all filters, click Reset. The filters are cleared, and any filters from the
custom lookup, if one exists, are restored.

4 Click OK.

Using the Lookup's Advanced Features

The Lookup has advanced features that allow you to create lookup views, create a
numeric lookup field, modify a lookup field, and export lookup data to Excel. If you
are new to the lookup, complete Using the Lookup's Basic Features on page 54
before starting these procedures.

Creating a Lookup View

For each lookup by company and by user, you can create up to 99 unique views.
When creating a lookup view, you can define your default view, add, remove, or
modify fields in the lookup, add or remove filters, as well as define several other
settings. After creating a lookup view, you can modify or delete the view at any time.
Keep in mind that any search criteria or filters you previously defined will not apply to
the new lookup view you create.

To create a lookup view
1 In the lookup window, click Custom.

2 On the Lookup Customization Wizard page, in the View field, select Create new
view and enter a description for the new view. Alternately, select an existing view
to modify.

3 To set the new lookup view as the default view, select the Default View check
box. Click Next.
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Using the Lookup's Advanced Features

S Lookup Customization Wizard

Select view parameters for Lookup - &P Vendor Master List

Company ABC, User Jws
View Create new view i
Description Basic
Dsfault View

é NOTE 4

The first column
indicated by an
asterisk (*) in the

In the second Lookup Customization Wizard page, add, remove, modify, or
reorganize the fields for the lookup view in the Selected Columns list box. In this
example, the TelephoneExt and LastPurchaseDate fields have been added to
the Selected Columns list box, and the ZIP Code field has been moved to the

Selected ) : -
Columns list box Available Fields list box.
cannot be
removed;
however’ it can S Lookup Customization Wizard EJE‘
be modified. For Select or modify the columnis) for Laakup - AP Vendor Master List
instructions, See Compary A8C, User JWS View - Basic
Modifying a Awailable Fighds Selected Columns
Lookup Field on Zip Code - *Vendor No
g APDivisiono () Name
page 62 Wendorha Phore Murber
Addressline1 TelsphoneEat
Sot Fisd
Addressline2 LastPurchaseDate
AddhsssLine3
ity
St (& . )
For more information Cournode Fg" n:c:;e Irt]nfot:mat;m
) rimeryContsc
about this button, See Faslln :/IoodL;f inls auLo(:)nléu ee
Creating a Numeric Emaltddress v or gn ga o p
Lookup Field or—————tzxrid. ] ! page bz.
page 61. [ <Back [ Mews J[ Fnsh | [ Cancel |

é NOTE

For a review on
how to create
filters, See
Filtering the
Lookup Criteria
on page 56.

5 Click Next to define additional settings, or click Finish if you have completed
customizing the view.

6 Use the third Lookup Customization Wizard page to add, delete, or modify
filters. To continue defining additional settings, click Next; otherwise, click

Finish.

Getting Started Guide
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Using the Lookup's Advanced Features

S Lookup Customization Wizard

Erter or modify the fiter[s) for Lookup - AP Vendor Master List
Company ABL, Ussr JWS View - Easic

Column
TiVendaNo .7 Bemmwith - 02

2 =

Operand Walug

[ < Back H Meat > H FEinizh ] [ LCancel

7 In the final Lookup Customization Wizard page, make any final changes to the

lookup view.

o Select the Initial Display check box to load data in the lookup at run time. If
you do not want data initially loaded in the lookup at run time because you
have a large number of records and want to perform a search before
displaying records, clear this check box.

o Inthe Title field, type a new title that will display in the lookup window title

bar.

o In the Default Search Column field, select a default field to appear in the

Search field in the lookup window.

o Inthe Default Search Option field, select a default field to appear in the

Operand field in the lookup window.

S Lookup Customization Wizard

Select other parameters for Loakup - &P Wendor M aster List
Company ABC, User /S View - Basic

Initial Disolaw
Title: Wendar List - Basic
Default Search Column | LastPurchaseDate

Default Search Option | Begins with b

[ < Back ]

[ Einish ] [ LCancel ]

8 Click Finish to see your newly created lookup view.
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An asterisk (*) -
. . Wendor Mo M arne: Phone Mumber TelephoneE=t | SortField  #
appears in the title 0 &
H : 02-AMERALR  American Alarm Service [617] 555-5561 AMERICAM,
bar to mdlcate that 02-AME= American Express Company [800) 555-6675 BEYS AMEX
this is a custom view, OZ-ARR0W  Arrowsmith Drirking W ater [213) 5555541 ARROWSM
. 02-4410 Avid Label [213) 5557693 AVID
not the Standard view D2BROWN  Brown & Johnson 213 555 BROWN
02-COMSULT - Tax Congulants, Ine.
generated by the 02EMPLOY  Employment Dievelopment Dept EMPLOYDE
software. 02-EQUAL State Board Of E qualization STATE
021RS Intemal Revenue Service [408] 5551234 9821 IRS
02-LEARMER  Roger'w. Leamner [714) 5551478 009e LEARMER
02-MCS Mes Long Lines [800) 555-5897 0321 MCS
02-MUTLIF Mutual Life Comparny MUTUALLIF
02-0FFICE OfficeMax [949) 555-9393
02-PACTEL Pacific Telechone 17141 5551478 4432 PACTEL ™
. < >
The asterisk (*) next
to the new view Search | LastPurchaseDate v |[Beginswith %
indicates tha.t this is View | Basic 7
the default view. |
(gt | corcet [R]S]O)
Found 18 recaords

The View field appears in the lookup window and the new view, Basic, displays
the newly added fields. In the example below, the new fields are TelephoneExt
and LastPurchaseDate, while the deleted ZIP Code field no longer appears.
Also, the title bar displays Vendor List - Basic because this title was defined in
the Title field in the last page of the wizard and was set as the default view.

Creating a Numeric Lookup Field

You can create numeric fields to add to the Selected Columns list box in the second
Lookup Customization Wizard page. Numeric fields are created by combining two or
more fields together using arithmetic operators.

To create a numeric lookup field

1

5

Getting Started Guide

In the second Lookup Customization Wizard page, click New Field to create a
new numeric field using simple arithmetic functions.

In the Lookup Customization Wizard - New Field window, in the Heading field,
type the name for the column/field.

Type the width and select the justification.

Type the mask.

S Lookup Customization Wizard - E]|E|E]

Heading <new field>

“width

Justification Right ~

Mask HHI T BR0.00-

Calculated field

Click the Calculated Field button to enter simple arithmetic calculations.
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6 In the Calculated Field Builder window, double-click a field in the Available
Fields list. This moves the field to the expression area. Select an operator,
choose another field from the list, and click OK.

S Calculated Field Builder (=3
Averagel aysOverDue-AverageDaysToPay
nnianan
Available Fields
LastCheckimt ~
RetentionR ate
Averagel aysToPay
AverageD aysOverDue
Balancelue
NumberDfinyT ol selnCale
- AP Termsnde

7 In the Lookup Customization Wizard - New Field window, click OK. The newly
created field automatically appears as a column in the Selected Columns list
box.

Modifying a Lookup Field
1 Inthe second Lookup Customization Wizard page, click Modify to alter the
selected field in the Selected Columns list box.

2 In the Lookup Customization Wizard - Modify window, make the desired
changes and click OK. For example, you can change the width of the key field to
zero if you do not want to display it in the lookup.

S Lookup Customization Wizard - ... EHE|E|

Heading Sort Field
Justification

(& ] ow [0
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Exporting Lookup Data to Microsoft Excel

You can export the data displayed in a lookup window to Excel if you hae the
appropriate security setup. You can also select a customized lookup view or perform
a search in the lookup window to display specific records, and then export the data

to Excel.

To export lookup data to Excel

1 In the lookup window, display the data to export to Excel.

S * Vendor List - Basic

EEX

or N

02-AMERALR
02-AMEX
0Z-ARROW
02:4VID
(2-BROWN
02-COMSULT
02-EMPLDY
(2-EQUAL
021RS
02-LEARNER
02-MCS
(02-MUTLIF
02-0FFICE
02-PACTEL
<

Airport 5 ravel

Fhone Nurnber

American Alaim Service {E1 71 555-5551

American Express

Company [800) 5558675

Arrawsmith Drinking W ater [213) 5555541

Avid Label
Brown & Johnson

[213) 555-7693
[213) B65-8321

Tax Consultants, Inc.

Ermployrment Develapment Dept

State Board Of Equalization

Internal Reverue Service [408) 5551234

Foger'w. Leamer
Moz Long Lines

[714) 5551478
B00] 5555897

Mutual Life Company

Officetdax
Pacific Teleohone

349) 555-3399
17141 5551478

TelephoneE st

BE7E

9821
Julic:)
0321

4432

Sort Field

EMPLOYDE
STATE

IRS
LEARMNER
MCS
MUTUALLIF

PACTEL ¥
>

Search | LastPurchaseDate

v |[Begins with v

View | *Basic ~

[Lsoeet | o [R]E] @)

[[ Find

— Excel button

Found 18 records

2 Click the Excel button. The data in the lookup window is exported to Excel.
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& NoTE

Click Preview to
review the listing
before printing.
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Printing Reports, Listings, or Forms

All reports can be printed, exported or written to a file, and stored for deferred
printing. You can print a report to a variety of printers or output devices. Additionally,
reports can be viewed before printing using the Preview feature.

Printing a Report, Listing, or Form

To print a listing in modules other than Job Cost, Material Requirements
Planning, Payroll, TimeCard, or Work Order

1 In the task window that has the Listing feature available (for example, General
Ledger Options), make the needed selections to the criteria in the window and
click Print.

2 Inthe listing window that appears, in the Printer field located in the lower-left
corner of the window, select the printer.

You can also select alternative printing methods, which are available in the
Printer field, including:

o

Export/E-mail: Reports can be exported to different file types, such as PDF
or Excel, and saved to your hard drive or e-mailed. For more information,
See Exporting or Printing to a File on page 70.

Data Only Export: This option allows only the data portion of the report to be
exported (header information is excluded). For more information, See
Exporting or Printing to a File on page 70.

Deferred: Report printing can be deferred allowing you to save reports on
your hard drive for printing at a future time. For more information, See Using
Deferred Printing on page 67.

Office Merge: If the Custom Office module is installed, you can merge your
data into a template such as a Microsoft Word or Excel template before
printing.

3 Click Print to print the listing.
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é NoTE

The standard set
of reports and
forms are
assigned a report
setting of
Standard.

é NoTE

You do not need
to save the report
setting or form
code setting to
print the report or
form.

To print a report or form in a module other than Job Cost, Material
Requirements Planning, Payroll, TimeCard, or Work Order

1

In the report or form window, select either a report setting or a form code.

S| Budget and History Report (ABC) 5/31/2010 (=153

Repart Setting

Description

Save ‘

STANDARD Q,

Budget and Histary Report

Setting Options

Type Print Repart Settings
Default Report Thiee Hole Punch

Number of Copies | |12

O
O
SortRepart By | Account Mumber K

Options
Print Zero Balance Accounts | Yes v
Print Tokals Only O

Infarmation to Print

Actual/Budget Fiscal Vear | &| S5z
ACTUAL POSTINGS 9 | 2010
ORIGINAL 2mo
ACTUAL POSTINGS 2003

Selections

Select Field
Account Number Al

Operand Walue ~

Main &l

Description Al -
Department All v

~

Wcaibestdc ! \CAIDEVPT

Keep ‘Window Open After

“ print [ Preview mE

You can either accept the default settings for the current report setting or form
code, or create a new report setting or form code. For more information, See
Creating a Report Setting on page 85.

In the Printer field located in the lower-left corner of the window, select the
printer.

You can also select alternative printing methods, which are available in the
Printer field, including:

Export/E-mail: Reports can be exported to different file types, such as PDF
or Excel, and saved to your hard drive or e-mailed. For more information,

Data Only Export: This option allows only the data portion of the report to be
exported (header information is excluded). For more information, See

Deferred: Report printing can be deferred allowing you to save reports on
your hard drive for printing at a future time. For more information, See Using

o
See Exporting or Printing to a File on page 70.
o
Exporting or Printing to a File on page 70.
o
& NoTE
Click Preview to Deferred Printing on page 67.
review the report
before printing. o

Office Merge: If the Custom Office module is installed, you can merge your
data into a template such as a Microsoft Word or Excel template before
printing.

After selecting or modifying the report setting or form code, click Print to print the

report or form.
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To print a report, listing, or form in the Job Cost, Material Requirements
Planning, Payroll, TimeCard, and Work Order modules

1 Inthe report, listing, or form window, the default printer is assigned automatically
and appears at the bottom of the window.

S Tooling Requirements Report

Sort Options

Report Cutoff Date

“wiork Order Mumber
12/31/2933

Page Break &fter Each Toal

Selection Al Starting Ending

Tool Number Q, Q,

Laser Printer [ Pirt ] Preview [ Prifter Setup.. @
Enter Tool Mumber Jw'S | ABC 843172010

2 To select a different printer or output device, click Printer Setup.

3 In the Name field, select a printer and click OK.

4 To preview the report, in the report window, click Preview.

S Tooling Requirements Report FEX
8

Getting Started Guide

TOOLING REQUIREMENTS REPORT
SORTED BY WORK ORDER NUMBER
TOOL NUMBER: (UNASSIGNED) DESC
WORK STEP WORK OPER START SCHEDULED
ORDER NUMBER CENTER CODE DESCRIPTION DATE HOURS
0095015 0000 CAB 00001 Assemble Chassis STARTED 975
0095015 0010 MBD 00001 Install memory chips STARTED 5.00
0095015 0020 MBD 00002 Install cards, port, STARTED 5.00
0095015 0030 PWR 00001 Assemble Power Suppl STARTED 10.00
0095015 0040 DRV 00001 See Sub-steps below: 05/23/03 0.00
0095015 0040-A-0010 DRV 00001 Attach floppy/hard d STARTED 5.00
0095015 0040-A-0020 DRV 00002 Attach ribben cables STARTED 475
0095015 0040-B-0010 DRV 00001 Attach floppy/hard d STARTED 4.00
0095015 0040-B-0020 DRV 00002 Attach ribbon cables STARTED 5.00
0095015 0040-C-0010 DRV 00001 Attach floppy/hard d STARTED 6.00
0095015 0040-C-0020 DRV 00002 Attach ribbon cables STARTED 475
0095015 0050 CAB 00003 Attach motherboard t STARTED 20.00
0095015 0055 CAB 00015 Install Power Supply STARTED 5.00
0095015 0060 CAB 00004 Attach case STARTED 0.00 ¥1
Search button =< L
(4] v 0] [ma[AJ)

Magnify button J I— Copy to Clipboard button

The Preview feature allows you to view all reports, including 132-column
reports. Use the Browse buttons to page through the report.

5 In the preview window, to copy the current page to the clipboard, click the Copy
to Clipboard button. Only text is copied; the header, footer, underlines, and
graphics are not copied.

6 To magnify the report, click the Magnify button. The zoom setting is retained
when you close the preview window.
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é NOTE

You can also print
the report by
clicking Print in
the report
window.
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7 To search for specific information in the report, click the Search button.

8 Click the Print button. A dialog box similar to the following appears, and the
report prints.

Using Deferred Printing

Deferred printing allows you to save reports on your hard drive for printing at a future
time. You can batch print multiple reports at one time without operator intervention
between reports. You can also specify the number of copies to print for each report,
as well as whether to retain the deferred report information for future use after
printing. In a multi-user environment, this feature can postpone the report printing
process if printers are not currently available, or it can speed up the posting process.

Deferring a Report

You must first set up reports to be deferred for future printing.

To defer the printing of a report in a module other than Job Cost, Material
Requirements Planning, Payroll, TimeCard, or Work Order

1 Access the report to defer (for example, the Budget and History Report in the
General Ledger module) and select the report options.

2 In the Printer field, select Deferred and click Print.

S| Budget and History Report. (ABC) 5/31/2010 (=13
RepartSeting | STANDARD Q, [ 52 []
Description Budget and History Fieport|

Setting Dptions

Type Piint Report Settings O Mumber of Copies 103
Defaul Repat Thiee Hole Funch O

Sart Fieport By | Ascount Humber v

Options

Print Zomo Bolancs Accourts |ves v

Print Totals Only O

Information o Print Actual/Budget Fiscal Year | 4] 5%
ACTUALPOSTINGS & 2010

ORIGINAL 2010
ACTUBLFOSTINGS 2009
Selestions
Select Field Operand Value -
Acsount Number Al -
Desciption Al -
Main Al -
Department Al -
~
] i ()
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é NOTE

In the Printer
Setup dialog box,
you can also
specify all report
pages to print or
a page range.
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3

4

In the Deferred Print Options dialog box, in the Number of Copies field, type the
number of copies to print.

S Budget and History Report

Deferred Print Options
Printer Laser Printer M
Number of Copies 1 (2

Purge &fter Printing

Secure Report D

Select or clear the Purge After Printing check box to either purge or retain the
report after printing. Select the Secure Report check box to restrict other users
from printing the report.

Click OK. The report generates to a deferred print file, which can be accessed
and printed at a later time.

To defer the printing of a report in the Job Cost, Material Requirements
Planning, Payroll, TimeCard, and Work Order modules

1

Access the report to defer (for example, the Open Work Order Report in the
Work Order module) and set the report options.

Click Printer Setup.

In the Printer Setup dialog box, click the Deferred option.

S Printer Setup

Output Type PFrinter

) Prirter Hame Laser Printer -

& Deferred

O Export Fie w'here Microsoft Diocument Imaging ‘wiiter Part:

Deferred Print Dptions

(@) Al Pages From Thru ) ~

() PageRange..... 12 9959 | Nuriber of Copies 1=
(& o= )0

In the Number of Copies field, enter the number of copies to print and click OK.
This field can also be modified before printing the deferred report.

In the Deferred Print Options dialog box, select or clear the Purge After Printing
check box to either purge or retain the report after printing. Select the Secure
Report check box to restrict other users from printing the report. Click OK.

In the report window, click Print. The report generates to a deferred print file,
which can be accessed and printed at a later time.
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Printing Deferred Reports

You can print one page of a deferred report or a range of pages. In addition, you can
print several copies of a report and more than one report at a time. If a report is
secured, only the user who initially deferred the report can print it.

To print deferred reports

1 To access and print deferred reports from the Desktop, use either of the
following methods:

@£ o Click the Deferred Print button on the Standard Buttons toolbar.
o Select File > Deferred Printing.
é NoTe 2 In the Deferred Printing window, select the report(s) to print.
Click the Change
View button to o To print all deferred reports, select the Module check box.

view reports in
the Deferred
Printing window
sorted by
module, user, or

date. Initially, the . T
reports are sorted o To print only selected reports, select each report check box individually.

by module.
S Deferred Printing g@@l
t () Select the deferred reports to print, then click. Print,

¥ Module

o To print deferred reports for a specific module, select the module's check
box. For example, select the General Ledger check box to print all deferred
reports in the General Ledger module.

= 4 General Ledger B Change View button
Budget and Histary R b4 jth - 2009 October 23 - 068:03:10 .
ot Dy et £ e e "' | @—— Refresh Report List button
3 Open Work Order Report .
b £1—— Preview Report button
@—1— Show/Modify Report Options

® button
L]

— Delete Report button

R

3 To preview a report, select the report and click the Preview Report button.

4 To export the report to a different file type (available only for reports in modules
other than Job Cost, Material Requirements Planning, Payroll, TimeCard, and
Work Order), click the Export Report button in the report preview window.

5 To change printing options for a specific report, select the report and click the
Show/Modify Report Options button.
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6 In the Deferred Report Options window, change the information in the Printer,
Number of Copies, Collated, Purge After Printing, Secure Report, and Page
Range fields. Click OK.

S Deferred Report Options @E]

Report Information
Fepoit Title Open Work Order Report
Module ‘work Order

User Jws

Campary HiZ

Date Created 2010 May 31

Defered Print Options

Printer Laser Printer e

Hurnber of Copies 10

Purge After Frinting

Secure Report O

Page Range (@) AllPages [ Total Report Pages: 1)
) Page From S Io

R0

7 In the Deferred Printing window, click Print to print the selected reports to their
assigned printers.

Exporting or Printing to a File

You can send the output of a report to another type of file, such as ASCII, delimited,
Excel, or dBASE IIl PLUS. These files can be used by spreadsheets, word
processing programs, or other applications and include the printer driver information.

Reports in modules other than Job Cost, Material Requirements Planning, Payroll,
TimeCard, or Work Order can be exported to additional files types, such as PDF or
HTML, and they can be saved to your hard drive or e-mailed. You can also elect to
export only the data portion of reports (header information is excluded) in these
modules.

To export a report in modules other than Job Cost, Material Requirements
Planning, Payroll, TimeCard, or Work Order

1 Access the report to export and select the report options.
2 In the Printer field, select one of the following options:
o Export/E-mail: Select this option to export the entire report.

o Data Only Export: Select this option to export only the data portion of the
report (header information is excluded).

3 Click Print.

4 Inthe Export dialog box, in the Format field, select the file type for exporting. Do
not select Lotus 1-2-3 (WK3) or Lotus 1-2-3 (WKS) in the Format field; those
formats are not supported by Crystal. Instead, use the Excel format.
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To e-mail the
report, select
Microsoft Mail
(MAPI) in the
Destination field.

é NoOTE
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sent to an ASCII
file, but not all
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printed to other
file types.
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default path, the
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designated disk.
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5

In the Destination field, select the location you are exporting to. For example,
you can export the report to your hard drive or to an application such as Excel.
Click OK.

To export or print to a file in the Job Cost, Material Requirements Planning,
Payroll, TimeCard, and Work Order modules

1

2

N

a

Access the report to print to a file and set the report options.
Click Printer Setup.

In the Printer Setup dialog box, select the Print to File check box to send the
output of the report to a different file type.

S Printer Setup

Output Type Printer
@ Printer Name Lasger Printer ~
2 Defened
O Esport File Wwhere Microsaft Document Imaging witer Port:
Frint tar File
Defered Print Options
3 From Thru
= Mumber of Copjes
. R )

Select the Export File option and click OK.

In the Export File Options window, select the file type. The type of report
selected determines the File Type options available.

S Export File Options

File Mame | ../home/textout/PCAIS00288wsmith1 TET

File Type
(@ Ascii Text File - Report Format

Delirnit Character

In the File Name field, accept the default path and file name or modify the path
and file name.

Click OK.

In the report window, click Print to print the report to a file.
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Sending Faxes

To send a fax from the software, a fax driver must be loaded in the Windows
workstation environment. The fax driver acts as a printer driver in the software.

To send a fax in a module other than Job Cost, Material Requirements
Planning, Payroll, TimeCard, or Work Order

1 Access the report and set the report options.

2 Inthe Printer field, select the fax driver.

3 Click Preview.

4 In the report preview window, click the Print Report button.
5 In the Print window, click OK.

6 A wizard or window applicable to your fax software appears. Enter the
necessary information, such as the recipient’s fax number, and send the fax.

To send a fax in the Job Cost, Material Requirements Planning, Payroll,
TimeCard, and Work Order module

1 Access the report and set the report options.
2 Click Printer Setup.

3 Inthe Printer Setup dialog box, in the Name field, select the fax driver and click
OK.

4 In the report window, click Print.

5 A wizard or window applicable to your fax software appears. Enter the
necessary information, such as the recipient’s fax number, and send the fax.

Paperless Office

You can use the Paperless Office module to fax, e-mail, and store forms in PDF
format. The Paperless Office module allows you to set up PDF storage and
electronic delivery options for documents in all Sage 100 companies. You can
specify separate settings for journals and registers, reports, period-end reports, and
forms.

This module also contains viewers in which you can view, move, delete, and
electronically deliver PDFs of customer forms, vendor forms, journals and registers,
standard reports, and period-end reports.

Purge utilities are also included which allow you to purge PDF documents as
needed.
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TimeCard, and
Work Order
modules.
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You do not need to enable this module in Company Maintenance; however, you
must enable Paperless Office functionality for each type of document you would like
to store and electronically deliver. For more information, see Set Up Paperless Office
in the Help system.

Batch Faxing

Batch faxing allows you to fax multiple forms in batches. During the faxing process,
forms addressed to the same fax number are collected and sent as a group with one
cover letter. Batch faxing is set up using Batch Fax Options or Fax Form Definition,
and requires either the Microsoft Fax Services or WinFax 10 fax driver.

The following forms are supported for batch faxing: Statement Printing, Accounts
Receivable Invoice Printing, Customer RMA Printing, RMA Receiver Printing, Sales
Order Printing, Picking Sheet Printing, Sales Order Invoice Printing, and Purchase
Order Printing. For more information, see Fax Multiple Forms in Batches in the Help
system.

Defining Formats for Standard Reports

You can specify the fonts, style, and data elements to print on the header and footer
sections of standard reports using Report Format Maintenance. You can also define
the font and style for the body of the report and add bitmaps to the header or
background of the standard report. The settings that you define establish a report
format.

You can define one report format per company code; a report format is not specific to
a user logon, workstation ID, or report. The only exception to this rule is the ability to
override the font in the body of the report in the Printer Preferences window; this
override is specific to workstation ID.
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To define a report format in the Job Cost, Material Requirements Planning,
Payroll, TimeCard, and Work Order modules

1 Select Library Master Setup menu > Report Format Maintenance. Every report
is divided into three sections: Header, Body, and Footer. By default, the header
é NoTe and footer use the Arial 12 point font and the body uses a variable size Times

Dot matrix New Roman font.

printers are not

designed to print

graphica| reports S Report Format Maintenance E]@

and ShOUld not be Edit Header Footer Body Bitmaps
used with this ABC Distribution and Header
feature.
Body
B =i Footer
[ oK I Lancel [ Copy
Zoom Factor 100% JWS | ABC ar3152010
é NoTe 2 In the Report Format Maintenance window, select Header > Company, Report
The other Title, or Subtitles and select settings in each window for the header. The
windows following is an example of the Company Information window. Access the
accessed from L . .
the Report additional windows from the Report Format Maintenance Header menu to select
Format settings for the report header.

Maintenance
Header menu are
similar in format

S Header Line 1 - Company Information

to this window. Print Company (& Mame
() Code
3 Both
O Blark
Font Name | Arial v | Size 12 |w
Atributss [ Bold Color -
[ satie Shading () Mone
[ Undeline O
Justification - O 50%
& 100%
Caption
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3 Select Footer > Sys Date and Page or App Date and User, and select settings in
& NoTe ‘ each window for the footer. The following is an example of the System Date and
The other window Page Number window.
accessed from
the Report
Format S Footer Line 1 - System Date and Page Number [EI
Maintenance
Footer menu is Frint Foater Ling 1
Similar in format Frint Spstem Date Include Swstem Time:
tO thIS WindOW. Frint Page Mumber
Frint Line Abowve Footer
Font Mame Size
Atributes  [] Bold Color
[ b
[ Undeine sl g ;;:e
Layout @ Date... Page ) B0%
) Page . Date ) 100
Date Caption | System D ate: |
Page Mumber Caption |F'age. |

4 Select Body > Font to define font, size and style settings for the body of the
report.

S Report Body - Default Font

= Marging are measured in inches.
Battom Margin =
Font Name Tirnes Mew Roman w | Mariable Ansi
Color Attributes [] Bold
[ o
[ Undeiline

5 Select Bitmaps > Header or Background to add a bitmap. Bitmaps can be
printed in the report header area and in the report background area.

S Header Bitmap

Print Header Bitmap
Name | #\MAS30\Home'Lib\ EMF\ABCLOGO.BMF | Click Auto-Scale to use the
Postion 20 automatic scaling feature. For more
[ e information, see Background
= UtD-acale — . .
(Bitmap) in the Help system.

6 In the Report Format Maintenance window, click OK to save your report
settings.
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é NOTE

The properties
defined for each
printer affect only
standard reports
and forms. These
properties do not
affect reports or

forms created
using SAP Warkstation Name
Crystal Reports. User Logon
-Step FoboPD Enable Graphice Printing for this Printer
Only printers ——pdabe FDF .
available to the g*;cg'gilfgﬁgi;:vgf;“mm'magew”‘e' Name [Detaul] v
workstation appear Size o Size] v
& Note in this list box. ol Defaut] v
The body Settings [JBold [ #sh [ Underline
you define in the Compressed Fon
Normal Font and Name [Defaul] v
Compressed o e
Font fields
Override the bOdy D Shaw Mative Printer Fonts Only D Bold D et D Qe
settings defined [ tecept | Cancd [ @]

in Report Format
Maintenance.

é NOTE

When printing
picking sheets,
packing lists,
Sales Order
invoices, sales
orders, Accounts
Payable checks,
Accounts
Payable
extended stubs,
1099 forms,
Accounts
Receivable
invoices,
purchase orders,
receivers, RMAs,
or Accounts
Receivable
statements,
select the form
code for printing
to a dot-matrix
printer. For more
information, see
Creating a Report
Setting on

page 85.
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7 Select Library Master Setup menu > Printer Preferences.

8 In the Printer Preferences window, select the Enable Graphics Printing for this
Printer check box to print reports according to the format defined in Report
Format Maintenance. The Use Graphic Report Format check box must also be
selected on the User Maintenance Preferences tab.

S Printer Preferences (ABC) 5/31/2010 2x

9 Inthe Printer Preferences window, define the appropriate settings in the Normal
Font and Compressed Font fields for the report body.

10 Click Accept to print reports for the selected printer in the printer list box
according to the format defined in Report Format Maintenance.

Setting Printing Preferences for Dot-Matrix Printers

To achieve optimum printing speed for dot-matrix printers, native fonts can be
selected through the Windows driver to increase print speed.

Some printer drivers may only have the Default selection available for the font. If this
is the case, you must download an updated driver for your printer from the printer
manufacturer's Web site or select another compatible driver emulation (refer to your
printer manual or consult a printer manufacturer for details). Each printer has unique
font options available. Most native font selections will print faster than the Default
font selection.

To set printer preferences for dot-matrix printers
1 Select Library Master Setup menu > Printer Preferences.

2 In the Printer Preferences window, select the dot-matrix printer from the printer
list.

3 Clear the Enable Graphics Printing for this Printer check box. This setting is
specific to the printer and overrides the global setting.
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4 Select the Show Native Printer Fonts Only check box. This is a temporary filter
and must be selected each time you access this window to change a font.

5 Inthe Normal Font Name field, select 10 CPI Draft, 10 CPI Courier (not Courier
New), or any font other than Default.

6 Inthe Normal Font Size field (to match the font selected in the Normal Font
Name field), select 10.

7 Inthe Compressed Font Name field, select a font based on the following
information.

o If you are using 8.5- x 11-inch paper on a standard-carriage printer, or 8.5- x
11-inch paper on a wide-carriage printer, select 17 CPI Draft,
17 CPI Courier (not Courier New), or any font other than Default.

o If you are using 11- x 14-inch paper, select a value between 10 and 15 (this
setting may vary, depending on which printer driver you are using).

8 Click Accept.

Customizing Forms

There are two types of forms: graphical and nongraphical. Graphical forms use the
SAP Crystal Reports writer to print, while nongraphical forms are generated directly
by the software and are not SAP Crystal Reports-related. All form printing tasks
allow you to customize the printing of forms and save the forms to the Forms file.
The Forms file contains a set of default formats for printing forms. You can modify
the default print formats or create new formats.

Use graphical forms when you want to have optimum control over the font, color, and
overall presentation quality of the form. You can also customize the graphical form
by adding bitmaps and company logos to it. These forms are designed for you to
send to your customers. For an example of a graphical form, see page 80.

Use nongraphical forms when you are concerned with the speed of printing, rather
than the overall presentation quality of the form. Nongraphical forms print faster
because they do not have bitmaps or custom fonts on them. Also, use nongraphical
forms if you are printing to a dot matrix printer. For an example of a nongraphical
form, see page 84.
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Customizing Graphical Forms

You can customize graphical forms, as well as create graphical forms, for all form
printing tasks using the Forms Customization feature. All graphical forms can be
printed using a Windows printer; however, you can only customize or create forms if
the SAP Crystal Reports software is available on your workstation. Only managers
or experienced Crystal Report users should have SAP Crystal Reports installed.

If a form is modified using the Forms Customization feature, the form will be modified
for all users and the current company. If you require more control of your form
customizations, use Library Master Report Manager to create forms for a specific
user and/or company.

To customize graphical forms in the Job Cost, Material Requirements
Planning, Payroll, TimeCard, and Work Order modules

1 Access the form printing task to customize.

S| Payroll Check Printing (=3
Bank Code B |G, woells Fargo Paroll Cking Direct Depasit Stubs...
Check Date 05/31/2010
First Check Number 004043
Check Message

Frint checks aready printed [ Frint in AMS51 Format [

Check Form Type | Stub, Check v | [ Multi Part Enable

Form Code A Ck Description | P/R Checks - Preprinted

Stub Lines 13

Selection All Starting Ending

Employee Mumber Ck Py Ck

Check Entry Mo, 9

“oabestds]SCAIDEYR? [ Print I Preview I Fririter Setup @

Enter bank code JwS | ABC 54312010

2 Inthe Form Code field, click the Lookup button and, in the Form Template
Selection window, select a form code and click OK. Several forms have three
default templates:

o A template for printing on a preprinted form
o A template for printing on plain paper

o A template for printing on plain paper in a graphical format with a marbled
background

Page 78



Customizing Forms

é NOTE

The Multi-Part
feature is
available only if
the Multi Part
Enable check box
is selected in the
form printing task
window.

Getting Started Guide

The preprinted form prints only data. The graphical form prints data, titles, and
graphical elements.

S Form Code List El@l

Code User Compary Description

[ | G )

3 To print forms to multiple locations, in the form printing task, click Multi Part

Enable to specify the printers to use for a multi-part form and click OK.

S Multi-Part Form Maintenance

Description | P/A Checks - Preprinted ‘

Capies ) Sz | | [Laser Frinter an My Documentsipdf | | Frinter 1 Setup...
Fat2 [ Copies |1 | [ I |
Fat3 [ Copies |1 | [ I |
Part4 [ Copies |1 | [ I |
Pats [ Copies |1 | [ I |

Jwso | ABC | BA31A20M0

For example, using the multi-part feature you can print the following copies of a
sales order:

o A file copy to your draft printer
o A warehouse copy to the printer located in your warehouse
o An original copy to your high-quality laser printer

In the form printing task, click Form to modify a form using the SAP Crystal
Reports software. The SAP Crystal Reports software launches with the form in
view.

If you do not have access to the SAP Crystal Reports software on your
workstation, a dialog box prompts you to install SAP Crystal Reports.

In SAP Crystal Reports, make the customizations to the form as needed, and
save the form.

After you have made modifications to your graphical forms using SAP Crystal
Reports, in the form printing task, click Print.
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7 Inthe dialog box that appears, click Align to print an alignment pattern using the
software to verify your new form layout. This is special logic built into the
software for graphical forms; printing or previewing your customized forms from
SAP Crystal Reports may not provide an accurate presentation of the final form
layout. Printing an alignment pattern is very important when making
modifications to graphical forms, such as checks or invoices.

The following is an example of a graphical marbled form created using SAP Crystal
Reports.

ABC Distribution and Service Corp.

THIRD NATIONAL BANK OF NOW HERE 004043
P.O._Box 1213 No.
DISTRIBUTION
COMPANY 004043
*THREE HUNDRED AND 13 /100
DATE AMOUNT
JERREY A THOMAS 5/31/2010 i i1 8

Py the

orderaf 4121 W.35th Street
Apartment 201
MILWAUKEE, WI 53151

004043
EMPLOYEE SOCIAL SEC. NO. PAY RATE PERIOD END
110000100 THOMAS. J 086-33-123% 13.850 HW 5/31/2010 004043
DEDUCTION
Regular 4000 554.00 8,1909.20 Fadersl W/H 1.28 1,010.68
Overtime 0.00 0.00 200.85 FICA 3163 456.10
Holiday 0.00 0.00 271.60 EILC. 0.00 3.05
Sick Pay 0.00 0.00 110.80 Madicars 7.63 133.07
Benus 0.00 0.00 24832 WI State W/H 2463 516.06
Vacation Pay 0.00 0.00 110.80 Health Insur 6000 540.00
Crdit Union 100.00 1,600.00
401k Plan 2770 5540
GROSS EARNINGS: 554.00 9,232 57 TOTAL DEDUCT: 253.87 4,323 45

NET EARNINGS: 300.13
EMPLOYEE PAY RATE PERIOD END

110000100 THOMAS. J 086-33-123% 13.850 HW 5/31/2010 004043
DEDUCTION
Regular 4000 554.00 8,1909.20 Fadersl W/H 1.28 1,010.68
Overtime 0.00 0.00 200.85 FICA 3263 456.10
Holiday 0.00 0.00 271.60 EILC. 0.00 3.05
Sick Pay 0.00 0.00 110.80 Medicars 7.63 133.07
Benus 0.00 0.00 24032 WI Statz WH 2463 516.06
Vacation Pay 0.00 0.00 110.80 Health Insur 6000 540.00
Crdit Union 100.00 1,600.00
401k Plan 2770 5540
GROSS EARNINGS: 554.00 9,232 57 TOTAL DEDUCT: 253.87 4,323 45
NET EARNINGS: 300.13
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Customizing Nongraphical Forms

é NoTE You can customize the size and alignment of nongraphical forms, as well as specify
To customize the print position for each data field on form printing tasks. You can also customize
Poigggaﬁltca' the heading and titles, and add or delete fields on the form. As you customize a
applic’able nongraphical form, you can save the settings using a single-character form code,
graphical forms which allows you to create and save multiple formats.

check box must

be cleared in the To customize nongraphical forms in the Job Cost, Material Requirements
module's setup Planning, Payroll, TimeCard, and Work Order modules

options window.
1 Access the form printing task to customize.

S Payroll Check Printing =13
Bark Code B |Q, wells Fargo Payroll Cking Direct Deposit Stubs...
Check Date 054312010
First Check Mumber 004043

Check Message

Frint checks already printed  []

Check Form Type | Laser - Check, Stub, Stub

Form Code 4 |@,  Description |Chk, Stub, Stub

Selection Al Starting Ending

Employee Mumber Q, prdrrrvrvril SN

Check Entry Mo, 9

“oabestde ] \CAIDEYPT [ Frint | Peview | Pinter Setup
Enter bank code Jw5 | ABC | 5/31/2010

2 In the form printing window, select a form code.
3 To specify the numeric masks and other options for the form, click Options.

4 In the Form Options window, customize the numeric masks that determine how
dollar amounts print and other information is used for the form, and then click
OK.

S Check Printing - Form Options @@
Farm Cade: A Chk. Stub, Stub

Numeric Masks

E arnings Hours H484.00- Pay Aate #EH#HR.000
Eam/Ded Amount HHH i 00- Eam/Ded Rate | HHHHH.000-
¥-T-D Amount HEHE 100 Check Amount | “H #HHE #1100

Print second check stub
Starting line number for 1st stub 21
Ending line number far 13t stub 42

Starting line number for 2nd stub | 43

[ oK I LCancel I Reset !.;]

Enter the mask to be used when printing the Earnings Hours Jws | ABC a/31/2010

5 In the form printing window, click Form.
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é NOTE

The form code
selected in the
form printing task
window appears
but cannot be
changed.
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6 On the Forms Customization Header tab, customize the general form alignment
information to suit your needs.

S Forms Customization E]El

Forms Code | & Chk, Stub, Stub

1. Header ] 2 Detail ]

Print Descriptions —‘—|

[] Print Compressed Click Reset

L] Form Fozd to reset the

Length of Farm 0EE information

‘wiidth of Form 030 to the

Top Margin [1/1000th inch) 350 Original
default

Tatal Mumber of Lines in Grouping | 013 values if you

Murnber of Lines per Detail [tem o have made

Starting Line Mumber for First ltern | 024 changes.

Jwso | ABC | BA31A20M0

Select the Print Descriptions check box to print headers individually for each
field. If this check box is cleared, all header printing is suppressed and
cannot be changed.

Select the Print Compressed check box to print wide forms that exceed the
standard 80-column format.

Select the Form Feed check box to force a form feed at the end of each form
to prevent creeping on subsequent pages. This makes setting the length of
the form unnecessary.

In the Length of Form field, set the length to 63 or 64 for Laser and Desk Jet
Windows printers. If you are printing to a dot matrix printer or a Device
Configurator Physical device, set the length to 66. An incorrect setting may
cause the form to creep if the Form Feed check box is not selected.

The Top Margin field setting is used only for forms printed using Windows

printer drivers. Changing the top margin moves the entire form up or down
vertically.
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7 On the Forms Customization Detail tab, specify the data to print and the print

positions of each available data field for the form.

S Forms Customization

Forms Code Chk, Stub, Stub

1. Header | 2 Detsil ]

MNET EARMINGS THIS CHECK.

Data Frint  Line Tab Misc Flag |:|

Description |:| Frint  Line I:I Tab l:l Description

Field Description Frint? Line Tab Frint? Line Tab Desciiption bizc

EMPLOY] ¥ 021 004 ---EMPLOYEE--—-

SOCIRL ¥ 0zz o032 ¥ 0z1 031

PRY RATE ¥ 0zz 045 ¥ 021 048

PRY DERIOD ENDING DATE ¥ 0zz 080 ¥ 0zZ1 055 PERIOD END

CHECE NUMBER ON STUB ¥ 0zz 071 ¥ 021 070 CHECE NO.

EMPLOYEE NUMBER ¥ 0zz o001 N

EMPLOYEE NaME ¥ 0zz 01z N

PRY METHOD ¥ 02z 058 N

PRY CYCLE ¥ 0zz 057 N

COLUMN 1 DESCRIPTION ¥ 024 003 ERRNINGS

COLUMN 1 HOURS HEADING ¥ 024 015 HCOURS v
JwS | ABC | B/31/2010

8 Click Accept to save the formats defined.
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The following is an example of a nongraphical form.

*THREE HUNDRED DOLLARS AND 13 CENTIS

004082

wEEREERZ00,15%

PERIOD END CHECE NO.

004082

YID

1,013.
458,
3.
133.
516.
540.
1,600.
.40

55

8

13

a7
08
oo

.45

PERIOD END CHECE NO.

05/31/10
JERRY A. THCMZS
4121 W. 35th Street
Apartment 201
MILWAUEEE WI 53151
———-EMPLOYEE--— SCOCIAL SEC NO PARY RATE

11-0000100 THOMAS,J 986-53-1239 13.850 HW 05/31/10

EARNINGS HCOURS AMOUNT YTD DEDUCTICH AMOUNT
Regular 40.00 554.00 8,199.20 Federal W/H 1.28
Cvertime .00 .00 290.85 FICR 32.63
Holiday .00 .00 271.60 E.I.C. 00
Sick Pay .00 .00 110.80 Medicare T7.63
Bonus .00 .00 249,32 WI State W/H 24.63
Vacation Pay .00 .00 110.80 Health Insur 60.00
Credit Union 100.00
401k Flan 27.70
GROS55 ERRNINGS: 554.00 9,232.57 TOTAL DEDUCT: 253.87

HET EARNINGS: 300.13
———-EMPLOYEE--— SCOCIAL SEC NO PARY RATE

11-0000100 THOMAS,J 986-53-1239 13.850 HW 05/31/10

EARNINGS HCOURS AMOUNT YTD DEDUCTICH AMOUNT
Regular 40.00 554.00 8,199.20 Federal W/H 1.28
Cvertime .00 .00 290.85 FICR 32.63
Holiday .00 .00 271.60 E.I.C. 00
Sick Pay .00 .00 110.80 Medicare T7.63
Bonus .00 .00 249,32 WI State W/H 24.63
Vacation Pay .00 .00 110.80 Health Insur 60.00
Credit Union 100.00
401k Flan 27.70
GROS55 ERRNINGS: 554.00 9,232.57 TOTAL DEDUCT: 253.87

004082

YID

1,013.
458,
3.
133.
516.
540.
1,600.
55,

.45
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é NoTE
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Creating a Report Setting

After selecting the options and selection criteria for a report, you can save these
selections for future use by using a unique report setting. You can create and save
any number of customized report settings per report and company. Use this
procedure to save a report setting based on an existing report setting.

To create a report setting

1 In the report window, in the Report Setting field, select the setting to use as the
basis for your new setting.

S| Budget and History Report (ABC) 5/31/2010 =113

Peport Getting | STANDARD Q, ﬂ
Description Budget and History Report

Setting Options

Type Print Fieport Gettings I Number of Copies 103

Default Repart Three Hole Punch I

Sort Repart By | Account Humber hd

Options

Frint Zero Balance Accounts | Yes v

Print Totals Orly (|

Information to Print Actual/Budget Fiscal Tear | | G52
ACTUAL POSTINGS & 2010

ORIGINAL 2010
ACTUAL POSTINGS 2009 3
Selections
Select Field Operand Walue ~
Account Humber All ©
Description All -
Main Al v
Department All -
e
\caibestde1\CAIDEYFT v Eﬁ:t" Wﬁdw};iz?x&a[ Bint | Preiew | _Selup

2 To save the report setting based on another report setting, modify the settings in
the report window, and then at the Save button click the drop-down arrow and
select Save As. You can also save the current report setting by clicking Save.

If Standard is selected in the Report Setting field in the report window, you
cannot save selections made on the Main or Select tabs in the report window to
the Standard report setting. The settings made in the report window will revert
back to the previous Standard report settings. When you click Save, the Save
As Report Setting window appears allowing you to save the changes to another
report setting name.

Page 85



Creating a Report Setting

é NoTE

Report and form
printer
information is
retained by
workstation and
form code. When
a new report
setting or form
code is created,
the workstation
ID and printer
information is
retained.
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In the Save As Report Setting window, in the Description field, type the
description for the report setting you are saving.

S Save As Report Setting Ejgl
Report Setting STaNDaRD

D escription Budget and History Repart
Setting Options
Type

Default Report
Office Merge Options

Always use this template D
Template

(& [ o]0l

In the Type field, select the report type option.

To save the report setting as your default report setting, select the Default
Report check box.

To set advanced settings for the report setting, perform the following steps:

a Click Advanced. In the Advanced Setting dialog box, select either the
Standard or Custom option to use a standard or custom report when printing
the report.

b If you selected the Custom option, enter the path to the custom report and
click OK.

In the Save As Report Setting window, click OK to save the report setting.
Changes made to an existing report setting are saved to a new report setting
name or to the current report setting name. The report setting that you created
will be available in the Report Setting field in the report window for future use.
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Setting Up Sage Intelligence Reporting

Sage Intelligence Reporting shows your Sage 100 data in Excel templates, which
you can view and customize.

Sage Intelligence Reporting is installed by default when you install Sage 100 and
run Workstation Setup. If you modified the default installation setting, you can install
Sage Intelligence Reporting at any time. Refer to the Sage 100 ERP Installation and
System Administrator’s Guide for installation instructions.

Before using Sage Intelligence Reporting, you must set up a repository and register
the product.

The repository will be used to store Sage Intelligence Reporting data, reporting
trees, report templates and other settings. Centralizing this information in one folder
has the following advantages:

e Using a single folder makes it easier to back up and restore the information.

e Multiple users can access the information.

To set up Sage Intelligence Reporting

1 Create a shared folder to serve as the repository. The folder can be created
locally or on a network; however, you must use a UNC format when entering the
repository path:

\\server\share name\repository folder name

2 Grant Sage Intelligence Reporting users read and write permissions to the
folder.

3 Open the Report Manager from within Sage 100. Select Sage Intelligence
Reporting > Reports > Report Manager.

4 When the window appears asking for the path to the repository, enter the UNC
path to the shared folder that you created, and click OK.

5 When a window appears asking you to run the license manager, click Yes.

6 Inthe License Manager window, enter your Sage customer account number and
serial number, and then click Apply.

The serial number is also referred to as an unlocking key. If you do not have
your serial number, see Finding Your Serial Number on page 88.

7 Click Perform Registration.

Click the Help button on any Sage Intelligence Reporting window for detailed
information about the product’s features.
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Finding Your Serial Number

If you do not have your Sage Intelligence Reporting serial number, you can find it
online at: https://customers.sagenorthamerica.com. You’ll need your user name and
password.

To find your Sage Intelligence Reporting serial number
1 Go to hitps://customers.sagenorthamerica.com and log on.
2 From the Activation Codes menu, click Details.

3 Inthe Product Details grid, in the Application column, look for Intelligence
Report Mgr. Your serial number is in the Unlocking Key column.

The serial number is case-sensitive. All special characters must be copied or typed
into the License Manger screen exactly as it appears in the Product Details grid.

You may have additional Sage Intelligence Reporting components listed in the grid.
The serial number for the Intelligence Report Mgr component will unlock all of the
components.
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Setting Up Sales Tax Information

Depending on the states in which you conduct business and the type of business
you have, you may be required to calculate sales tax on items sold and items
purchased. The software allows you to calculate, track, and report sales tax
information. To calculate sales tax, you must define information in Sales Tax Class
Maintenance, Sales Tax Code Maintenance, and Sales Tax Schedule Maintenance.
Sales tax information defined in these tasks is available to all companies.

The setup of sales tax information consists of the following four-part process:

1 Defining Sales Tax Classes: The tax class is used to define tax classifications.
These tax classes are then assigned to each sales code, inventory item and
miscellaneous charge code.

2 Defining Sales Tax Codes: The tax code is used to define whether a tax class is
taxable. It is also used to define a tax rate, if applicable.

3 Defining Sales Tax Schedules: A tax schedule groups individual tax codes.

4 Assigning Sales Tax Schedules: Tax schedules are assigned to each vendor and
customer based on the vendor's location or purchase address and the
customer's location or ship-to address.

Defining a Sales Tax Class

The first step in defining sales tax information is to define different types of tax
classifications in Sales Tax Class Maintenance. The following three tax classes are
defined automatically by the system and cannot be deleted: Nontaxable (NT),
Taxable (TX), and Taxable Freight (TF). A tax class must be defined for each
classification of goods and services that are taxed at different rates.

To define a sales tax class
1 Select Library Master Setup menu > Sales Tax Class Maintenance.
2 Enter a class in the Tax Class field.

3 In the Description field, type a description for the tax class and click Accept.
Repeat steps 2 and 3 for each tax class you need to define.

S Sales Tax Class Maintenance (ABC) 5/31/2010 ([=1E9)

Tax Class Dezcription
1 |NT Nortaxable
2 |TF Taxable Freight
3| T® Tauable

arm

(2 [ s ]BIO)
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After defining sales tax classes, assign the tax classes to sales codes, inventory

items, and miscellaneous charges.

Defining a Sales Tax Code

After defining tax classes, you must define sales tax codes in Sales Tax Code
Maintenance. You must set up a tax code for each tax jurisdiction (such as state,
county, local or province) to which your business reports sales tax information. The
defined sales tax codes determine the rate to calculate for each tax class defined in
Sales Tax Class Maintenance and are used to determine if sales tax is calculated on

both items sold and purchased.

To define a sales tax code

1 Select Library Master Setup menu > Sales Tax Code Maintenance.

2 Enter a code in the Tax Code field and type a description in the Description field.

S Sales Tax Code Maintenance (ABC) 5/31/2010 g@@l

P

Tan Code 44 bR
Dezcription | Califomia Short Description | Califo
Taxable Limit 0.0 Calculate Sales Tax on Retention O
Expense ta Yendar/ltem Taw on Tax [l Tax Class
Tax Class Dezcription Tax Rate Sales | Purchases | Monrecoverable Pot
Montaxable 000000 1 1 000
T anable Freight 000000 Il Il 000
Taxabls E.000000 [ (] 000
000000 (] (] 000

=10

3 If the tax code you are defining has a limit, type it in the Taxable Limit field. For
example, some tax jurisdictions have a limit for the amount of sales tax that can

& NoTE

The Calculate 4
Sales Tax on
Retention check
box is available
only if the Job
Cost module is
installed.

5 Complete one of the following options:

on the invoice amount less retention.

be defined on an invoice, sales order, or receipt.

In the Short Description field, type a short description. This description will be
used when printing tax detail on forms.

o Select the Calculate Sales Tax on Retention check box to calculate sales tax

o Clear the Calculate Sales Tax on Retention check box to calculate the sales
tax on the full invoice amount, regardless of retention. For more information,
see Sales Tax Code Maintenance - Fields in the Help system.

6 Complete one of the following options:

Getting Started Guide
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& NoTE

The Tax Class
field next to the
Tax on Tax check
box is the only
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tax class; you
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in Sales Tax
Class
Maintenance.

é NoTE

If your tax
jurisdiction
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o Select the Expense to Vendor/ltem check box to allocate the
non-recoverable portion of purchase's sales tax to the vendor's expense
account in Accounts Payable or to the inventory account in Purchase Order.

o Clear the Expense to Vendor/ltem check box if the non-recoverable portion
is not to be allocated. For more information, see Sales Tax Code
Maintenance - Fields in the Help system.

Complete one of the following options:

o Select the Tax on Tax check box if this tax code is subject to taxation by other
tax jurisdictions, and proceed to step 8.

o Clear the Tax on Tax check box if the tax code is not subject to tax on tax,
and proceed to step 9. For more information, see Sales Tax Code
Maintenance - Fields in the Help system.

If you selected the Tax on Tax check box, enter a class to be used for tax-on-tax
calculations in the Tax Class field (next to the Tax on Tax check box).

For each tax class defined (except for tax class NT which cannot be maintained
or deleted), complete the following fields:

a Select the Sales check box to calculate sales tax for this code, or clear the
Sales check box if sales tax should not be calculated.

b In the Tax Rate field, type the tax rate percentage to use for calculating
taxes.

¢ Select the Purchases check box if purchases are taxable for the tax class
entered and proceed to step d. Clear the Purchases check box if the
purchases are not taxable and proceed to step e.
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d If the Purchases check box is selected, type the percentage of the purchase
tax that cannot be recovered in the Non-Recoverable % field. Type 0 (zero)
at this field if all purchases sales tax is to be posted to the Accounts Payable
sales account. Type 100 at this field to post all of the purchases sales tax to
the non-recoverable account.

e Click OK.

10 Click Accept. The following example shows a rate of 7.25 will be calculated for
items assigned to the Taxable (TX) tax class for items sold.

S Sales Tax Code Maintenance (ABC) 5/31/2010 Q@E‘

Tax Code 4 4 & ki
Description | Califomia Short Description | Califo
Taxable Limit 0.0 Calculate Sales Tax on Retention O
Expense to YendorAtem Tax on Tax 1 Tax Class
Tax Class Dezcription Tax Rate Sales | Purchases = Monrecoverable Pct
1 | NT Montaxable 000000 O O .00
2 | TF T anable Freight 0o0oog O O .00
Bl Tawable 7250000 [ O .00
4 000000 [ [ .ong

Defining a Sales Tax Schedule

After defining sales tax codes, use Sales Tax Schedule Maintenance to group tax
codes that make up a total sales tax rate for assignment to customers and vendors,
and to establish whether tax detail will print on sales orders and invoices. For
example, if a specific county requires that you calculate both state and county tax,
create a sales tax schedule that groups the state and county tax together.

To define a sales tax schedule
1 Select Library Master Setup menu > Sales Tax Schedule Maintenance.

2 Enter a schedule in the Tax Schedule field and type a description in the
Description field.

3 Inthe Tax Code field, enter a tax code to add to this tax schedule and click OK.
Repeat this step for each tax code you want to add to the tax schedule.

The sequence in which the tax codes are entered is very important because of
tax-on-tax calculations and the establishment of the primary tax code. If a tax

code is taxable by another tax code, it must be calculated first. For example, if
tax code CA is taxable by tax code OR, CA would have to be calculated first to
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get an accurate calculation for the OR tax code. The first tax code entered will
become the primary tax code. The primary tax code is used during the
calculation of taxable and nontaxable amounts on each invoice and
printing/updating of sales tax history.

5| Sales Tax Schedule Maintenance (ABC) 5/31/2010 (=113
Wb
Description Bart
Frint Tax Code Detail O
Tax Code Diescription

1 |Ca California [Primarny] E‘- -

2 | CABA Bart
ER &

[ Accept I Cancel I Delete

4 Click Accept.

Assigning a Sales Tax Schedule

After sales tax schedules are defined, use Customer Ship-To Address Maintenance
and Purchase Address Maintenance to assign each customer and vendor address

to a default tax schedule. Default tax schedules can be changed when entering
transactions.

To assign a sales tax schedule to a customer address
1 Select Accounts Receivable Main menu > Customer Maintenance.

2 Enter the customer number. Click the drop-down arrow in the top-right corner of
the window, and then click Ship To Address.

3 In the Customer Ship-To Address Maintenance window, enter the Location
Code field.
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4

To assign a sales tax schedule to a vendor address

1

2

In the Tax Schedule field, enter a sales tax schedule and click Accept.

S| Customer Ship-To Address Maintenance

LocationCods || 14 4 b Bl

Narme | Awnet Processing Com |

Address ‘wfestern Division & Residential Address []
1317 Mwf, 19th Street

ZIP Cods 32653
City Mirimar State

County [0%# @ Urited States of America

Telephone [213) 5559842 Ext

Fax

E-mail &ddress =i

Contact q

Warehause Q

Salesperson 0200 (@, Shely westiand
Sales Tax

TatSohedds 4 |G Calfomia
(o [ o [ e 8]0

Select Accounts Payable Main menu > Vendor Maintenance.

Enter the vendor number. Click the drop-down arrow in the top-right corner of

the window, and then click Purchase Address.

In the Purchase Address Maintenance window, enter the location code.

In the Tax Schedule field, enter a sales tax schedule and click Accept.

S Purchase Address Maintenance

Location Code 4 bk Pkl

Name | AR/ PROPERTY |

Address 1001 PICO BLYD [%]

2IP Code 92145
City |05 ANGELES State
County usa @

Telephone 1213) 59346353 | Ex | |

Fax (2131 533-8000 | BatchFax []

E-mail Address B4
Contact Q,

Sales Tax

Tax Schedule l:lq

Exemption Mo, enFile  []
[ Accept ] LCancel I Delete
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Understanding How Sales Tax is Calculated

This lesson provides examples of how sales tax is calculated. These examples use
the WI (Wisconsin) and WI MIL (Milwaukee) sales tax codes:

e The WI (Wisconsin state tax) sales tax code is set up to calculate sales tax at a
rate of 5% on all sales and purchases for items assigned to the Taxable tax
class. It will not calculate sales tax on other tax classes.

e The WI MIL (Milwaukee city tax) sales tax code is set up to calculate sales tax at
a rate of 1% percent on all sales for items assigned to the Taxable tax class. It
will not calculate sales tax on purchases or items assigned to other tax classes.

WI (Wisconsin) S Sales Tax Code Maintenance (ABC) 5/31/2010 CEX
sales tax code —— TaxCoe [wi | M 4 b W
Description |Wiscomsin | Short Description
Taxable Limit Calculate Sales Tax on Retention 1
Erpense to Vendar/Item Tanon Tax O Taw Class l:l
Tax Class Description Tax Rate Sales  Purchazes | Monrecoverable Pot
1 |MT Maontaxable 000000 1 1 i} ?@‘ >
2 |TF Tauable Freight .00oo0a [l [l unli]
3 Tanable 5.000000 [ [l unli]
oooon - [ | 000

S Sales Tax Code Maintenance (ABC) 5/31/2010

Tax Code ,—| 4 4 b b

Diescription |Mi|waukee | Short Diescription
Tanable Limit Calculate Sales Tax on Retention O
Expenze toVendor/ltem Taxon Tax O Tax Class l:l
WI MIL
(Milwaukee)
| t d Tax Class Description Tax Rate Sales | Purchases | Monrecoverable Pet
sales lax code 1 |NT Nortaxable 000000 O O ooo =R
2 |TF Taxable Freight 000000 O O ooo
3 |T= Taxable 1.000000 g O ooo
N 1a oooooo . [ O 1

These examples also use the WI (Wisconsin) and WI MIL (Milwaukee) sales tax
schedules:

e The WI (Wisconsin) sales tax schedule has the WI sales tax code assigned to it.
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e The WI MIL (Milwaukee) sales tax schedule has both the WI sales tax code and
the WI MIL sales tax code assigned to it because Milwaukee city requires that
both state and city tax be calculated for taxable items.

Wi (Wisconsin) S Sales Tax Schedule Maintenance (ABC) 5/31/2010
sales tax — 1 TaSchedie W4 b
schedule Diescription |Wiscunsin |
Frint Tax Code Detail O
Tax Code Diescription

‘Wigconsin [Primary|

LY

m

S Sales Tax Schedule Maintenance (ABC) 5/31/2010 CBEIx
TaxSchedue [WIHL | 14 4 b Bl ZIP Fief... | |State XRef ..
Description |
Frint Tax Code Detail O
Tax Code Description
1 | Wizcongin [Primary) r-?c" -
2 | wiMIL ilwaukes
EN &
WI MIL
(Milwaukee)
sales tax
schedule

[ Accept ] LCancel [ Delete
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Example 1 - How Sales Tax is Calculated in Accounts

Receivable

This example shows how sales tax is calculated on Accounts Receivable invoice

1000158-IN. Invoice 1000158-IN has the following settings:

e On the Invoice Data Entry Header tab, the WI tax schedule is selected.

e On the Invoice Data Entry Lines tab, line item 1 (Standard Gadget) is $145 and is
assigned to the TX tax class, indicating that this item is taxable.

S| A/R Invoice Data Entry (ABC) 5/31/2010

9=1E3

1. Header ] 2. Lines ] 3 Totals } 4, Credit Card }
Lustomer No O1-RGSUPPL Q, [ [ R &S Suppl Com.
Invoice Date 52 |7 Teims Code |01 @ Net30Days
Due Date /302000 | Ship Method UPS RED 28
Discount Date 53200 | el 0200 |G, Shelywestland
WI (WlSCOnSln) Net Invaice Smt Comment
sales tax
. Sales Tax
scheduleis 1 oo w1 |qQ RiintInvsics
Wisconsi ——
selected. eansn S AR Invoice Data Entry (ABC) 5/31/2010 CEx
1. Header ] 2 Lines ] 3 Totaks ] 4 Credit Card }
- | Quick Row | 1] B =T
Tom Tode Rty Fioe P e
1| 100 1.000 145,000 145.00 ¢
2 .non .0oo .o
< | >
Desciption | Standard Gadget ~
. GLAccount | 400-01-00
TX tax class is o w0 |B
selected for the TanClass | TX =
Standard Gadget.
BO

Getting Started Guide
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Tax Calculated Using the WI (Wisconsin) Sales Tax Schedule

To view how tax is calculated for invoice 1000158-IN, on the Invoice Data Entry
Totals tab, click Tax Detail. In the Tax Detail window, you can see that $7.25 (100 x
7.25%) in sales tax has been calculated for the WI (Wisconsin) sales tax schedule.

WI (Wisconsin) — feabede] B

| R &5 Supply Corp.

sales tax Documert | 1000158IN | Customer | 01-RSSUPPL
schedule is——— Schedule Wi Wisconsin
selected.
Tax Code Tax Amaount Exemption Number
1wl | 72

Tarable Sales | Nontaxable Sales|  Ex

14500

0o

Total

— $7.25 sales
tax is

calculated.

Tax Calculated Using the WI MIL (Milwaukee) Sales Tax Schedule

For invoice 1000158-IN, if the tax schedule on the Invoice Data Entry Header tab is
changed from WI tax schedule to WI MIL tax schedule, sales tax is calculated for
both the Wisconsin state (WI) and Milwaukee city (WI MIL) sales tax codes because
both of theses sales tax codes are included in the WI MIL tax schedule.

The following Tax Detail window shows how tax is calculated when the

WI MIL tax schedule is used. You can see that $7.25 (100 x 7.25%) in sales tax is
calculated for the (WI) Wisconsin sales tax code, and $1.45 is calculated for the (WI
MIL) Milwaukee city sales tax code. The total tax amount is now $8.70 for the

Invoice.
WI MIL S Tax Detail \Z‘@@
(Milwaukee) Document | 10001564N | Customer | 01-RSSUPFL | P35 Supply Corp.
sales tax —————F schedie Wi MIL Milwaukee
schedule is
selected. Tax Code Tax Amaunt Eremption Mumber | Taxable Sales | Montaxable Sales|  Ex
1wl 7.25 145,00 il
2 WML 1.45 145,00 il

Total

— $8.70 sales
tax is
calculated.
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Understanding How Sales Tax is Calculated

For invoice 1000158-IN, let's say the same tax schedule of WI MIL is used; however,
the tax class for the Standard Gadget item on the Invoice Data Entry Lines tab has
been changed from TX (Taxable) to NT (Non Taxable).

The following Tax Detail window shows how tax is calculated when the
NT tax class is assigned to the Standard Gadget item. Notice that sales tax is not
calculated and the entire invoice displays as a nontaxable sale.

S| A/ Invoice Data Entry [ABC) 5/31/2010 =113

Header | 2Llines | 3 Totals | 4 CreditCard |
ik [ e
Item Code Guantity Price Amaunt Camment
1 100-A4 | q, 1.000 146.000 145.00
2 ono ooo oo
£ b
Description | Standard Gadget ~
: GL & t | 400-07-00
NT tax class is —
o8
selected for the ToxClass |NT -
S Tax Detail
Standard
Gadget, Drocument ‘10001 58-IM | Cugtomer | 01-RESUPPL Fi & 5 Supply Corp.
—————————— | Schedue |WIMIL Milwaukee
e
Tax Code Tax Amaount Exemption Number | Taxable Sales | Montaxable Sales|  Exg
1 il ] oo 145.00
2 | wilMIL ] oo 145.00
< >
Total .00
No sales tax
is calculated.
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Getting Started Guide

Example 2 - How Sales Tax is Calculated in Accounts
Payable

This example shows how sales tax is calculated on Accounts Payable invoice
75-145. Invoice 75-145 has the following settings:

e On the Invoice Data Entry Header tab, the WI MIL tax schedule is selected.

WI MIL
(Milwaukee)
sales tax
schedule is
selected.

$100.00 is entered
for the distribution

amount.

On the Invoice Data Entry Lines tab, the total distribution amount for this invoice
is $100.00. This is the total purchase amount that is taxable.

S| A/P Invoice Data Entry (ABC) 5/31/2010 (=13
VendorNo. M4 b
Name Stevens Supply ‘
Imvoice No. =]
1. Header ] 2 Lines W
Invoice Date 54312010 |50 Temms Code 02 |G, 2% 10 D&YS, NET 30 DavS
Irtvoice Amourt 106.00 Irwvoice Due Date E/30/2010 [
Freight .00 Digcount Due Date | 641072010 |E=H)
Sales Tax ao Dizcount Amolnt 210
Subject to Discaunt 105.00
Prepaid Invaoice ck
Hold Papment [] Separate Check  []
Sales Tax Camment || |
— Schedule W L__hiluzukee
LSRN S| A/P Invoice Data Entry (ABC) 5/31/2010 %]
Use T
A T et R L
Mame Stevens Supply ‘
Invoice Mo B
1. Header ] 2 Lines w
G/L Account Amount Comment
N LY 1000
2 | | 00
Description | Freight - ‘#est
Distribution Balance | 5.00 | Tatal | 100.00 ‘
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Tax Calculated Using the WI MIL (Milwaukee) Sales Tax Schedule

To view how tax is calculated for invoice 75-145, on the Invoice Data Entry Header
tab, click Tax Detail. In the Tax Detail window, you can see that $5.00 (100 x 5%) in
sales tax has been calculated for the WI MIL (Wisconsin) sales tax schedule.

Remember that the WI MIL tax schedule calculates tax for both WI (Wisconsin state)
and WI MIL (Milwaukee city) sales tax codes. Also, keep in mind that the WI sales
tax code is set up to calculate sales tax on items which are purchased (the
Purchases check box is selected in Sales Tax Code Maintenance), but the WI MIL
tax code is not set up to calculate sales tax on items which are purchased (the
Purchases check box is cleared in Sales Tax Code Maintenance). Therefore, sales
tax on purchased items is calculated only for the WI (Wisconsin) state tax code even
though both tax codes (WI and WI MIL) are included in the WI MIL tax schedule.

S Tax Detail |Zl@@

Document 75-145 Wendor 01-5TEY Stevens Supply
WI MIL Scheduls w1 MIL Milwaukes
(Milwaukee)
Sales tax Tax Code Tax Amaunt Use Tax Amt Exempt on File Exemption Number | Ta: %
schedule is 1l ’ .............. 500 oo g
2 W MIL oo oo
selected.
$5.00 sales
2 2 tax is
Total 5.00 —calculated.
(o o)
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Changing Sales Tax Information

Changing Sales Tax Information

é NoTe After setting up sales tax information, you may need to modify the sales tax
This lesson information defined in Sales Tax Class Maintenance, Sales Tax Code Maintenance,

assumes that
sales tax
information has
been set up and

or Sales Tax Schedule Maintenance. For example, the sales tax rate for a tax
jurisdiction changed.

sales tax has To change sales tax information

already been
calculated on 1
transactions.
2
3
AWARNING 4
Before

recalculating
sales tax, back up
all data files.

é NoTE

Records that
have a status of
"invalid tax
calculation"
display the
Recalc Tax
button in data
entry.

Getting Started Guide

Select Library Master Setup menu > Sales Tax Class Maintenance, Sales Tax
Code Maintenance, or Sales Tax Schedule Maintenance.

The following warning appears informing you that changes you make may
impact sales tax calculations and reporting. Click OK.

Wathing: Any changes may impact salss tax caloulations and rsporting. Maks sure that no data entry is in
progress. Aftsi changes have been mads, run the Sales T Caloulation Utlity fom Accounts Fieceivable or
Accounts Payable Utiites for each applicable company.

Make the necessary changes in Sales Tax Class Maintenance, Sales Tax Code
Maintenance, or Sales Tax Schedule Maintenance and click Accept.

You must recalculate the sales tax previously calculated on unposted invoices,
sales orders, purchase orders, manual checks, returns, and so on. To do this,
select either Accounts Payable Utilities menu > Sales Tax Calculation or
Accounts Receivable Utilities menu > Sales Tax Calculation.

In the Sales Tax Calculation Utility window, select one of the following options:

o Select the Recalculate Sales Tax for all Records option to recalculate taxes
for all records.

o Select the Recalculate Sales Tax for Flagged Records Only option to
recalculate taxes for only those records that are flagged as invalid tax
calculation.

S A/P Sales Tax Calculation (ABC) 5/31/2010 [Z)[01/[X]

Sales tax will be recalculated for the items selected below bazed on
the current tax information.

Repetitive [nvoices P/0 Orders
AP Irvoices P/0 Receipts
A/P Marual Checks P40 Retumns
Recalculate Sales Tax for all Records @
Recalculate Sales Tax for Flagged Records Only [

Proceed LCancel m
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6 Click Proceed to recalculate the sales tax.
When sales tax is recalculated, the following occurs:

e Only unposted transactions are affected. This includes sales orders, purchase
orders, and unposted invoices.

e Posted transactions are not modified. If the amount of sales tax calculated was
incorrect, you must manually adjust the invoice through a credit memo or debit
memo.

e Recurring invoices are updated if they contain sales tax information.
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Appendix A

Troubleshooting

What are System Messages?

When the computer system encounters a condition requiring your attention, a
System Message dialog box appears.

System Message Dialog Box Example

Q File PR_OTABC.S04 not found

Info End
e ]

Some messages reflect a normal operational situation, such as the printer being
off-line. Usually, the resolution is simple, and you can proceed without difficulty.

Other messages can indicate a problem with the hardware or with the data files. A
problem of this nature may require help from your Sage business partner.

Obtaining Additional Information

If a message dialog box appears, click Info in the Error window to obtain additional
information about the message.
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What are System Messages?

Q File PR_014BC.504 not found.

Click System Info to view
information regarding the
workstation. This utility does not
contain information specific to

the software.

S| Error

Q

Infa ]

Program  PRWMAS
Stack

Error Information
Filz
Charnel
Key

Last Channel Dpened
Last Charnel Accessed

Application
LA Level

Bytes Free
Serial Number

Errar #12: File does not exist [or already exists]

Line 0410
] Global Flags ] Dump ] Files ]I
provides.ddf FR1 PR Emploves Master File
552
[nfa)
B
1
Payroll [4.40]
4.40
29,586,686
0510-001-0030024 System Info

(o] o [ 5[0)
S Error 7|@
° Error #12: File does not exist [or already exists]
Program  PRWHAL Line 0410
Irfo ] Stack ] Global Flags ] Dump ] Files ]
Open Files Public Programs
[ Chan I Name ] [ Program | Size
0 CAIS0028ZEMD (Terminal ID) TAE. PVC 11217 (A
& SYOCTL Systewm Control File FOLDER. PVC 23205
32757 SY Modula. M4T _WINPROC.TEL 1z040
JE2758  5Y_RolelSecurity.M4T _WINPROC 13842
32753 SY UserSacuricy.M4T _WINDROC.DSP 29368
32760  S5Y_Task.M4T 5Y_HOTEEY 3127
32761 SYOCTL System Control File GROUP. PYC 3721
JE276Z  5Y_RolelSecurity.M4T COLOR.DSP 2660
32763 SY UserSecuricy.M4T _WINAPI 17745
32764 SV _User.M4T _INFO 14036
32765 SY_Task.M4T $Y_FILE.DPVC 15151
32766 providex.dde 5Y_SESSION. PVC 3193
32767 providex.ddf $Y_PERSONALIZE. 2858
_NSGLIE 564
CHM_NOMADSLINK ZELE w0
= [B]0)

Before contacting a Sage business partner, write down any system messages
appearing on your monitor. Copy the message and indicate the program and
function being performed when the message occurred. Click the Print button to print

the error information.
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Appendix B

é NOTE

The eBusiness
Manager, Job
Cost, Material
Requirements
Planning, Payroll,
and Work Order
modules are not
available for
Sage 100
Premium.

Overview of Module Startup

This appendix explains how to successfully upgrade from another business
management system to Sage 100 for the following modules:

e Accounts Payable

e Accounts Receivable

e Bank Reconciliation

e Bar Code

e Bill of Materials

e Common Information Setup Wizard
e eBusiness Manager

e General Ledger Setup Wizard

e Inventory Management Setup Wizard
e Job Cost

e Material Requirements Planning

e Payroll

e Purchase Order

e Sales Order

e Work Order

This appendix is organized alphabetically for ease of reference.
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Accounts Payable

é NOTE

Set up your sales
tax codes, sales
tax classes, and
sales tax
schedules in
Library Master
before using the
Accounts
Payable Setup
Wizard.

Getting Started Guide

Accounts Payable

Accounts Payable Setup Wizard

The Accounts Payable module includes an Accounts Payable Setup Wizard that you
must perform to convert your existing companies and account structure.

The Accounts Payable Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the Accounts Payable module for new
companies; you must complete this wizard and the Conversion Process on
page 107 before using the Accounts Payable module.

Data You Need

Before using the Accounts Payable Setup Wizard, have the following information
assembled and available for use:

e Your General Ledger Chart of Accounts

e Your bank account number(s) for the checking accounts used by Accounts
Payable

e Alist of standard payment terms offered by your vendors
e Alist of your vendors, including address and phone numbers
e Alist of all unpaid invoices to be processed

To obtain correct information from your Accounts Payable module, you must first
bring it up to date with your existing accounts payable system.

Conversion Process

Complete the following process to ensure that your system is current. These steps
should be performed after completing the setup wizard and after adding all of your
information to the Accounts Payable module.

To convert your existing accounts payable system
1 Identify all unpaid invoices as of your last closed accounting period.

2 Prepare an adding machine tape totaling the invoices. This amount should
equal the account balance for Accounts Payable in your general ledger.

3 Set the posting date to the last day of the last closed accounting period.

4 Using Invoice Data Entry, enter these invoices into the system. Enter the
outstanding balance amount for each invoice as of the end of the last closed
accounting period. During the distribution process, post the entire distribution
balance to your Accounts Payable general ledger account. This is done
because you have already expensed these invoices in a previous accounting
period, and to do so again would duplicate those expenses.
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Accounts Payable

AWARNING

If the General
Ledger check box
is cleared in
Accounts
Payable Options,
select the
General Ledger
check box before
proceeding with
the update.
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12

13

By posting to the Accounts Payable account, both a debit and an automatic
credit are generated in the same amount to the Accounts Payable general
ledger account; therefore, the two amounts offset each other and there is no
effect on the general ledger. After the conversion process, you would not
normally post to the Accounts Payable general ledger account, but would post
to individual general ledger accounts, as appropriate.

As an alternative to this procedure, clear the General Ledger check box in
Accounts Payable Options. You can then distribute invoices to their respective
accounts and no general ledger postings are made. If you use this alternate
procedure, be sure to select the General Ledger check box again in Accounts
Payable Options after the conversion process has completed and you have
updated the Daily Transaction Register.

Print the Invoice Register. The total shown on the Invoice Register should equal
the total on the adding machine tape prepared in step 2. If it does not, an error
has been made. Check your adding machine tape and Invoice Register, return
to Invoice Data Entry and make any necessary corrections, and then reprint the
Invoice Register.

Update the invoices.

Print the Aged Invoice Report available on the Accounts Payable Reports
menu, and retain a copy of this report for your accounting files. Again, the total
on this report should equal the adding machine tape total.

Run Period End Processing by selecting Period End Processing from the
Period End menu, and then clicking Proceed.

Reset the posting date to the first day of the current accounting period.

Using Invoice Data Entry, enter any invoices you have received since the last
closed accounting period. (These invoices should not include any invoices
entered in step 4.) Post the distribution balance of each invoice to its
appropriate general ledger account (not to the Accounts Payable general ledger
account). Print the Invoice Register and update the invoices.

Prepare an adding machine tape totaling any checks you have written since
your last closed accounting period.

Using Manual Check and Payment Entry, enter these checks (step 11) into the
system. If the check paid an invoice previously entered (step 4 or 10), no
general ledger distribution is required. Type the invoice number exactly as you
did when you entered it in step 10. If the check paid an invoice that you did not
previously enter, you must distribute it to the appropriate general ledger
account(s).

Print the Manual Check and Payment Register. The total should equal the total
of the adding machine tape prepared in step 11. If it does not, return to Manual
Check and Payment Entry, correct the necessary entries, and reprint the
Manual Check and Payment Register. When the register total and the adding
machine tape agree, update the manual checks.
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Accounts Receivable

é NOTE

Set up your sales
tax codes, sales
tax classes, and
sales tax
schedules in
Library Master
before using the
Accounts
Receivable Setup
Wizard.
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14 Print the Aged Invoice Report and verify that all invoices paid by the manual
checks recorded in step 12 are listed as paid.

You are ready to begin using your Accounts Payable module.

Accounts Receivable

Accounts Receivable Setup Wizard

The Accounts Receivable module includes an Accounts Receivable Setup Wizard
that you must perform to convert your existing companies and account structure.

The Accounts Receivable Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the Accounts Receivable module for new
companies; you must complete this wizard and the Conversion Process on

page 109 before using the Accounts Receivable module.

Data You Need

Before using the Accounts Receivable Setup Wizard, have the following information
assembled and available for use:

e Your General Ledger Chart of Accounts

e Alist of jurisdictions in which you sell and collect sales tax and their tax rates
e Alist of standard payment terms offered to your customers

e Alist of your customers, including addresses and phone numbers

e Alist of all invoices to process

e Alist of all payments to process

To obtain correct information from your Accounts Receivable module, you must first
bring it up to date with your existing accounts receivable system.

Conversion Process

Complete the following process to ensure that your current accounting system is in
balance. These steps should be performed after completing the setup wizard and
after adding all your customers to the Customer file. If you maintain Accounts
Receivable customers using a balance forward method, it is not necessary to enter
each invoice. For balance forward customers, total all unpaid invoices for each aging
category, and enter an invoice for each aging category for each customer.

To convert your existing accounts receivable system
1 Identify all unpaid invoices as of your last closed accounting period.

2 Prepare an adding machine tape totaling the invoices. This amount should
equal the account balance for Accounts Receivable in your general ledger.
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A WARNING

If the General
Ledger check box
is cleared in
Accounts
Receivable
Options, select
the General
Ledger check box
before
proceeding with
the update.
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Set the posting date to the last closed accounting period.

Using Invoice Data Entry, enter the invoices using the original invoice dates.
During the distribution process, post the entire distribution balance to your
Accounts Receivable general ledger account number. These invoices are
already posted in an accounting period, and to post them again would duplicate
the postings.

By posting to the Accounts Receivable general ledger account, both a credit
and an automatic debit are generated in the same amount to the Accounts
Receivable general ledger account. The two amounts offset each other and
there is no effect on the general ledger.

After the conversion process, you will not normally post to the Accounts
Receivable general ledger account, but will post to individual general ledger
accounts, as appropriate.

As an alternative to this procedure, in Accounts Receivable Options, clear the
General Ledger check box. You can then distribute invoices to their respective
accounts and no general ledger postings will occur. If you use this alternate
procedure, be sure to select the General Ledger check box again in Accounts
Receivable Options after the conversion process has completed and you have
updated the Daily Transaction Register.

Print the Sales Journal. The invoice total shown on the Sales Journal should
equal the total on the adding machine tape prepared in step 2. If it does not, an
error has been made. Check the adding machine tape and the Sales Journal,
return to Invoice Data Entry and make any necessary corrections, and then
reprint the Sales Journal.

Update the invoices.

Print the Aged Invoice Report and retain a copy of this report for your
accounting files. The total on this report should equal the adding machine tape
total.

Run Period End Processing by selecting Period End Processing from the
Period End menu, and then clicking Proceed.

Reset the posting date to the first day of the current accounting period.

Using Invoice Data Entry, enter any invoices billed since the last closed
accounting period. (These invoices should not include any invoices entered in
step 4.) Post the distribution balance of each invoice to its appropriate general
ledger account (not to the Accounts Receivable general ledger account). Print
the Sales Journal and update the invoices.

Prepare an adding machine tape totaling any cash receipts you received since
your last closed accounting period.
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Using Cash Receipts Entry, enter these cash amounts. For the deposit amount,
enter the adding machine tape total prepared in step 11. If the checks entered
represent payment for a previously issued invoice (step 4 or 10), no general
ledger distribution is required. If any checks represent payment for an invoice
not previously issued, you must distribute the amounts to the appropriate
general ledger accounts.

Print the Cash Receipts Journal. The total should equal the adding machine
tape total in step 11. If it does not, return to Cash Receipts Entry, correct the
necessary entries, and reprint the Cash Receipts Journal. When the journal
total and the adding machine tape agree, update the cash receipts.

Print the Aged Invoice Report and verify that all invoices that are paid by the
cash receipts recorded in step 12 are listed as paid.

You are ready to begin using your Accounts Receivable module.

Bank Reconciliation

Conversion Process

To obtain correct information from your Bank Reconciliation module, you must first
bring it up to date with your existing bank reconciliation system.

To convert your existing bank reconciliation system

1

Verify that all modules being integrated with Bank Reconciliation are fully
installed and operational.

Select the Bank Reconciliation check box in General Ledger Options, Accounts
Payable Options, Accounts Receivable Options, Payroll Options, and Purchase
Order Options, as appropriate.

Manually reconcile the last bank statement for each account that you want to
use in your bank reconciliation system.

Perform all preliminary startup activities (define the files and set the accounting
date using the ending date shown on your last reconciled bank statement).

Using Bank Code Maintenance, set up the bank code using the ending bank
balance from your last reconciled bank statement as a source for the bank
account number and ending bank balance.

Enter all outstanding checks from your last reconciled bank statement, using
Check, Deposit and Adjustment Entry. If checks are already being processed
through the Accounts Payable or Payroll module, these outstanding checks
should be checks that were updated in the check update process, but are not
shown on the last bank statement. On the Check tab, clear the Cleared check
box when these checks are recorded.
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7 Enter all outstanding deposits or adjustments (those not shown on the bank
statement) in Check, Deposit and Adjustment Entry. If deposits are being
processed through the Accounts Receivable module, these outstanding
deposits should have been updated, but not shown, on the last bank statement.
On the Check tab, clear the Cleared check box when these deposits and
adjustments are recorded.

Print the Bank Reconciliation Register to verify the accuracy of the information
entered. If the information on the register is correct, your Bank Reconciliation
module is now ready to use.

Bar Code

Before using the Bar Code module, create and have available the folder names that
will be used for importing files from the handheld computer. Enter this information in
Bar Code Setup menu > Bar Code Options.

Bill of Materials

Bill of Materials Setup Wizard

The Bill of Materials module includes a Bill of Materials Setup Wizard that you must
perform to convert your existing companies and account structure.

The Bill of Materials Setup Wizard provides several pages of questions and options
that aid you in quickly setting up the Bill of Materials module for new companies; you
must complete this wizard and the Conversion Process on page 112 before using
the Bill of Materials module.

Data You Need

Before using the Bill of Materials Setup Wizard, have the following information
assembled and available for use:

e Your General Ledger Chart of Accounts
e A single-level bill of materials listing for all bills you want to maintain

e Any miscellaneous codes that you want to set up, such as for overhead, labor,
and outside processing

To obtain correct information from your Bill of Materials module, you must first bring
it up to date with your existing bill-processing system.

Conversion Process

Complete the following process to ensure that your system is current. These steps
should be performed after completing the setup wizard.
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Common Information

To convert your existing bill of materials system

1 Prepare a list of existing bills from your system. Verify that the information is
current.

2 Review the structure of the existing bills. When possible, employ the modular
bill structure to save work and provide increased flexibility.

3 Enter the bills in Bill of Materials Maintenance.

4 Enter the component items, miscellaneous codes, and comments for each bill.
If your bills use bill options, examine the bills to verify that all options and any
option interactions are taken into account.

5 Print a Single-Level Bill of Materials Report for all bills and verify the information
against the listings provided in your old system. Print an Indented Bill of
Materials Report and verify that the bill structure is correct and complete.

6 Print a Bill Validation Report. This report examines the entire Bill of Materials
file. Correct any inaccuracies and print this report again, if applicable.

You are ready to begin using your Bill of Materials module.

Common Information

Common Information Setup Wizard

The Common Information module includes a Common Information Setup Wizard
that you must perform to convert your existing companies and account structure.

The Common Information Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the Common Information module for new
companies; you must complete this wizard before using the Common Information
module.

Data You Need

Before using the Common Information Setup Wizard, have the following information
assembled and available for use:

e Alist of miscellaneous items and charges
e Alist of sales tax jurisdictions

e Your bank account number(s)
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é NOTE

For more
information
regarding setup
procedures, refer
to your
eBusiness
Manager
Installation
Guide.
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eBusiness Manager

eBusiness Manager Setup Wizard

The eBusiness Manager module includes an eBusiness Manager Setup Wizard that
you must perform to convert your existing companies and account structure.

The eBusiness Manager Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the eBusiness Manager module for new
companies; you must complete this wizard before using the eBusiness Manager
module.

Data You Need

Before using the eBusiness Manager Setup Wizard, have the following information
assembled and available for use:

e The IP address and port number for each of the three servers (1IS, SMTP, and
Web Engine)

e Alist of your item categories

e Alist of user IDs and passwords to assign to Internet-enabled customers (for the
.order applet only)

e Alist of user ID e-mail addresses and the company to which each user is
assigned

General Ledger

General Ledger Setup Wizard

The General Ledger module includes a General Ledger Setup Wizard that you must
perform to convert your existing companies and account structure.

The General Ledger Setup Wizard provides several pages of questions and options
that aid you in quickly setting up the General Ledger module for new companies; you
must complete this wizard and the Conversion Process on page 115 before using
the General Ledger module to process your daily transactions.

Data You Need

Before using the General Ledger Setup Wizard, you should have the following
information assembled and available for use:

e Your General Ledger Chart of Accounts
e A Trial Balance from the last completed accounting period

e Copies of your company's latest financial statements, including the Income
Statement and Balance Sheet
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Conversion Process

To obtain correct information from your General Ledger module, you must first bring
it up to date with your existing general ledger system.

e If you are converting at the beginning of a fiscal year, or require only the
beginning balances for each account, see Enter Beginning Balances in the Help
system.

e If you are converting in the middle of a fiscal year and want to record activity for
each accounting period of the current year, as well as beginning balances, see
Enter Data for Each Period in the Help system.

Use these procedures as a checklist to ensure that your current accounting system
is in balance. These procedures should be performed after completing the General
Ledger Setup Wizard.

Inventory Management

Inventory Management Setup Wizard

The Inventory Management module includes an Inventory Management Setup
Wizard that you must perform to convert your existing companies and account
structure.

The Inventory Management Setup Wizard provides several pages of questions and
options that aid you in quickly setting up the Inventory Management module for new
companies; you must complete this wizard and the Conversion Process on page 115
before using the Inventory Management module.

Data You Need

Before using the Inventory Management Setup Wizard, have the following
information assembled and available for use:

e Your General Ledger Chart of Accounts

e Alist of all inventory items containing costs, prices, on-hand quantities,
warehouse locations, and reorder requirements

e Any shipping documents, receiving reports, open purchase orders, or adjustment
vouchers that must still be processed

To obtain correct information from your Inventory Management module, you must
first bring it up to date with your existing inventory system.

Conversion Process

Complete the following process to ensure that your current accounting system is in
balance. These steps should be performed after completing the setup wizard and
after adding all your inventory items to the Inventory file.
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To convert your existing inventory system

1

10

1"

Prepare a list of current on-hand quantities for all inventory items. You can use
the balances as of your last closed inventory accounting period end, or you can
perform a physical count.

In Inventory Management Options, in the Current Inventory Period field, select
the previous period (the last closed period).

In Inventory Management Options, clear the General Ledger check box.
Set the posting date to the last day of the last closed accounting period.

In Transaction Entry, enter each item's current on-hand quantity as a receipt by
selecting Receipts in the Transaction Type field. You must enter the quantity on
hand and the unit cost for each item.

You can use a single receipt reference for entering the on-hand quantities for all
items, or items can be separated into any logical grouping and entered under
different references.

Print the Transaction Journal and verify all information. If necessary, use
Transaction Entry to make corrections.

When the register is correct, perform the Transaction Journal update.

In Period End Processing, select Full Period End Processing. The current
period is set to the period in which you begin processing.

In Inventory Management Options, select the General Ledger check box.
Reset the posting date to the first day of the current accounting period.

Enter any transactions, such as sales, issues, and receipts for the current
accounting period to bring the inventory management system up to date. Use
Transaction Entry to record the transactions.

You are ready to begin using your Inventory Management module.

Job Cost

Data You Need

Before using the Job Cost module, have the following information assembled and
available for use:

Your General Ledger Chart of Accounts
Determine your accounting and billing methods
Estimates or estimate worksheets

Job contracts with all pertinent information
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e Estimated price lists

e Standard cost code list

e Job types list

e Burden rate information

e Overhead rate information

e Invoices or billing documents that need to be processed

To obtain correct information from your Job Cost module, you must first bring it up to
date with your existing job costing system.

Conversion Process

Complete the following process to ensure your system is current. These steps
should be performed after completing System Startup and adding all jobs, cost
codes, and cost types to the Job Cost master file.

To ensure that all accounting modules integrated with Job Cost, including the
Accounts Payable, Accounts Receivable, Payroll, Purchase Order, and Sales Order
modules, do not double post transactions that have been entered as part of the
conversion process, it is recommended that the conversion process be performed
immediately after the completion of period-end processing for all integrated
modules.

To convert from your existing job cost system

1 Prepare a list of job-to-date cost information, detailed by cost code and cost
type, for each open job. You should use the information from your last closed
accounting period. If you are changing the coding format of your cost codes
from your previous system, indicate the new cost codes to use for each entry.

2 In Job Cost Options, clear the Post to G/L for Direct Cost Transactions and Post
to G/L for Billing & Cash Receipt Transactions check boxes. The job-to-date
conversion information to be entered should not be posted to the general
ledger.

3 Setthe Job Cost accounting date to the last day of the last closed accounting
period.

4 In Job Posting Entry, enter a separate batch of direct cost entries for each job.
Enter a separate entry with the job-to-date units (quantity) and job-to-date cost
for each cost code and/or cost type detail. If each job contains a large number
of cost code and/or cost type detail, update each batch separately.

5 If the Accounts Receivable module is not integrated with Job Cost, use Job
Posting Entry to enter billing and cash receipt transactions for each job up to
the last closed accounting period. Do not enter any billing or cash receipts that
should be recorded in the current accounting period.
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6 If the Accounts Receivable module is integrated with Job Cost, use Job Billing
Entry to enter all invoices that have been billed to outstanding jobs. Use
Accounts Receivable Cash Receipts Entry to enter cash receipts for job
invoices. If Job Cost is integrated with the General Ledger module, you must
use General Journal Entry to back out these general ledger postings generated
for these transactions to prevent double posting of information previously
recorded.

Additionally, if invoices relating to job billing are entered in the Accounts
Receivable module before the installation of Job Cost, reverse these invoices
using the Adjustment feature in Accounts Receivable Invoice Data Entry before
recording the job invoices. This prevents doubling the invoice information in the
Accounts Receivable module.

7 If work-in-process accounting is being used, the initial job billing entries
generate postings to the General Ledger module that adjust the appropriate
work-in-process accounts with the total accumulated costs for each job. You
must use General Journal Entry to back out these general ledger postings to
prevent double posting of information previously recorded.

8 Print the Work in Process Report for all jobs, and check the cost code, cost
type, and job-to-date information printed. Print the Job Billing History Report to
check the billing and cash receipt transactions. If any errors are found, use Job
Posting Entry or Job Billing Data Entry to make corrections.

9 Perform full period-end processing to clear the period-to-date information
affected by the conversion data.

10 Reset the accounting date to the first day of the current accounting period.

11 Enter cost and billing transactions for the current accounting period.
Transactions can be entered directly in the Job Cost module by integration with
other modules.

12 In Job Cost Options, select the Post to G/L for Direct Cost Transactions and
Post to G/L for Billing & Cash Receipt Transactions check boxes. This allows all
future transactions to post to the general ledger.

You are ready to begin using your Job Cost module.
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Material Requirements Planning

Before using the Material Requirements Planning module, have a list of available
warehouses ready for use, and know whether each warehouse is a standard
distribution/manufacturing warehouse or a distribution warehouse that will receive
only transferred goods. This information will be used to define warehouse groups in
Warehouse Group Maintenance.

Payroll

Data You Need

Before using the Payroll module, have the following information assembled and
available for use:

e Your General Ledger Chart of Accounts
e Alist of the earnings and deductions used for payroll processing

e Employer federal, state, and local tax ID numbers for each tax jurisdiction in
which your employees are paid

e Tax tables for the federal, state, and local tax jurisdictions in which your
employees are paid

e Alist of employees, complete with personal information and quarter-to-date and
year-to-date earnings and deduction history

To obtain correct information from your Payroll module, you must first bring it up to
date with your existing payroll system.

In compliance with federal and state tax reporting requirements, payroll systems
operate on a calendar-year basis. As the year progresses, large quantities of
quarter-to-date and year-to-date data are accumulated; therefore, the ideal time to
convert from your existing payroll system to the Payroll module is on January 1. If
this is not possible for your company, guidelines for installing the Payroll module at
different times during the year follow.

Converting at the Beginning of the Calendar Year

If you are installing the Payroll module at the beginning of the calendar year, enter
your information into the module; however, make no entries at any quarter-to-date or
year-to-date fields. These fields are maintained automatically as payroll is
processed throughout the year. With these tasks completed, you can proceed
directly to the year's first payroll cycle.

Converting in the Middle of the Calendar Year

To obtain correct year-end totals and proper tax calculations from your Payroll
module, you must first bring it up to date with your current payroll totals, including
quarter-to-date and year-to-date earnings and a record of vacation, sick leave, and
benefit accrued hours.
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To record year-to-date information

1

Perform the normal setup procedures, and enter all employee information into
the system.

In Payroll Options, in the Current Quarter field, select the previous quarter.

In Payroll Options, clear the General Ledger check box. This ensures that no
general ledger postings are made from the Payroll module. Because the prior
quarter information should already be reflected in your general ledger balances,
allowing the postings to update would result in duplicate postings.

Enter manual checks using Payroll Data Entry for each employee to record the
year-to-date earnings and tax information. In the Pay Cycle window, verify the
Manual Taxes check box is selected and the Print Checks check box is cleared.
You can use the previous quarter number as the check number. Enter all
earnings, deductions, and tax information using the year-to-date information
from the end of the previous quarter.

If an employee has worked in more than one state, make sure the earnings
information is entered separately for each state.

Print the Payroll Data Entry Audit Report and verify all information. If necessary,
make any corrections using Payroll Data Entry.

Print the Check Register and perform the Check Register update.

In Period End Processing, select Quarter End Processing. The Current Quarter
field in Payroll Options increments to the current quarter.

If you are converting your payroll at the beginning of the current quarter,
proceed to step 5 in the procedure below.

If you are converting in the middle of the quarter, you must record each check
issued during the current quarter using the following procedure.

To record current quarter checks

1

Enter each check issued during the current quarter as a manual check in
Payroll Data Entry (that is, in the Pay Cycle window, clear the Print Checks
check box and select the Manual Taxes check box). Enter the earnings,
deductions, and tax information exactly as written on the original checks. You
can enter a combined total of the checks issued for each employee. This
method, however, does not provide the full detail and complete audit trail
facilitated by a detailed entry of each check.

Print the Payroll Data Entry Audit Report and verify the accuracy of all entries. If
necessary, make any corrections using Payroll Data Entry and reprint the
Payroll Data Entry Audit Report.

Print the Check Register and perform the Check Register update.

Print the Daily Transaction Register and perform the Daily Transaction Register
update.
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5 Print the Quarterly Tax Report and the Payroll Check History Report, and verify
all employee information.

6 Print and verify the Benefits Register. If adjustments are necessary, access
individual employee records in Employee Maintenance.

7 In Payroll Options, select the General Ledger check box. This allows all future
payroll processing to post to the general ledger.

You are ready to begin using the Payroll module.

Purchase Order

Purchase Order Setup Wizard

The Purchase Order module includes a Purchase Order Setup Wizard that you must
perform to convert your existing companies and account structure.

The Purchase Order Setup Wizard provides several pages of questions and options
that aid you in quickly setting up the Purchase Order module for new companies;
you must complete this wizard and the Conversion Process on page 121 before
using the Purchase Order module.

Data You Need

e Before using the Purchase Order Setup Wizard, have the following information
available for use:

e Your General Ledger Chart of Accounts

e Alist of vendor quantity discount rates you use for inventory items
e Alist of all addresses to which you have orders shipped

e All open purchase orders and back orders

e All receipts, invoices, returns, and material requisitions as of your last closed
accounting period

To obtain correct information from your Purchase Order module, you must first bring
it up to date with your existing purchase order system.

Conversion Process

Complete the following process to ensure that your current accounting system is in
balance. These steps should be performed after completing the setup wizard.

To convert your existing purchase order system
1 Gather all open purchase orders as of your last closed accounting period.

2 Prepare an adding machine tape totaling the orders.
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3 Use Purchase Order Entry to enter the orders into the system. In Default Values
for Purchase Order Entry, clear the Print Purchase Orders check box to prevent
the conversion orders from being reprinted. Next, on the Purchase Order Entry
Header tab, select Standard Order in the Order Type field and Open in the
Order Status field for each order.

Partially received or invoiced purchase orders cannot be processed using the
system without double posting to the General Ledger and Inventory
Management modules. These orders should be processed manually until they
are completed. To enter these orders, you must enter only the unreceived
balance on each order as the original order quantity. There are no such
restrictions for outstanding orders that have not received any partial receipts or
invoices against them.

4 Print the detail version of the Open Purchase Order Report for all order types
and orders with an open status. The total on this report should equal the total on
the adding machine tape you prepared in step 2. If the totals do not agree,
return to Purchase Order Entry and make any necessary corrections and reprint
the report as an audit record of your outstanding orders.

5 Record all receipts, invoices, returns, and material requisitions that you have
received since the last closed accounting period to bring the system completely
up to date.

You are ready to begin using your Purchase Order module.

Sales Order

Sales Order Setup Wizard

The Sales Order module includes a Sales Order Setup Wizard that you must
perform to convert your existing companies and account structure.

The Sales Order Setup Wizard provides several pages of questions and options that
aid you in quickly setting up the Sales Order module for new companies. You must
complete this wizard and the Conversion Process on page 123 before using the
Sales Order module to process your daily transactions.

Data You Need

Before using the Sales Order Setup Wizard, have the following information
assembled and available for use:

e Your General Ledger Chart of Accounts
e A list of standard miscellaneous charges and items used in your business

e Alist of item part numbers sold by your business (if the Inventory Management
module is not integrated with Sales Order)

e Alist of your shipping rates
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e All open orders and back orders
e A Customer Listing from your Accounts Receivable module
e An Inventory Item Listing from your Inventory Management module

To obtain correct information from your Sales Order module, you must first bring it up
to date with your existing order processing system.

Conversion Process

Complete the following process to ensure that your current accounting system is in
balance. These steps should be performed after completing the setup wizard. First,
enter any unpaid invoices, as of your last closed accounting period, into the Open
Invoice file. This process is performed using the Accounts Receivable module.
Second, use the Sales Order module to enter any open orders or back orders into
the system.

To convert your existing sales order system
1 Identify all open orders as of your last closed accounting period.
2 Prepare an adding machine tape totaling the orders.

3 Using Sales Order Entry, enter these orders into the system. Use the standard
order type for standard sales orders, and the open order status for open orders.
When entering the Sales Order Entry default values, clear the Print Sales
Orders and Print Pick Sheets check boxes, and enter 00 in the No. of Ship
Labels field in the Default Values for Sales Order Entry dialog box to prevent
these documents from being printed.

4 |dentify all open back orders as of your last closed accounting period.
5 Prepare an adding machine tape totaling the back orders.

6 Using Sales Order Entry, enter these back orders into the system. Use the
back-order order type for back orders, and the open order status for open
orders.

7  Print the detail version of the Open Sales Order Report for all order types and
the open order status. The Open Order and Open Back Order totals shown on
this report should equal the totals on the adding machine tapes prepared in
steps 2 and 5. If the totals do not agree, check your adding machine tapes and
the Open Sales Order Report. Return to Sales Order Entry and make any
necessary corrections, and then reprint the report as an audit record of your
outstanding orders.

You are ready to begin using the Sales Order module.
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Data You Need

Before using the Work Order module, have the following information assembled and
available for use:

e Your General Ledger Chart of Accounts

e Alist of work center locations, including the number of employees and number of
standard hours available per week at each location

e Alist of operations to be performed, including cost and overhead calculations
and general ledger production cost accounts

e Alist of employees (optional), including labor rates and social security numbers
e Alist of labor crews (optional), including the employees in each crew

e A calendar of days when the entire shop is closed

e A calendar for each work center with exceptions to the shop calendar

e Alist of tools to be used during operations (optional)

To obtain correct information from your Work Order module, you must first bring it up
to date with your existing work order system.

Because the Inventory Management module is integrated with Work Order, it may be
impractical to bring the system up to date and reconstruct the original material cost
information that should have been recorded. If you have installed the Inventory
Management module, it is difficult to record past material issue transactions for work
orders without affecting the current inventory balances.

The easiest and most effective way to convert the Work Order module is to enter
only new work orders into the system. Do not record any transactions related to
preexisting work orders using the Work Order module. You can use the Inventory
Management module or the Bill of Materials module to record issues and receipts
related to these work orders. For labor and miscellaneous expenses, the general
ledger can be adjusted directly using General Ledger General Journal Entry. If the
duration of your work orders is short, you can quickly complete the conversion
process after all of the preexisting work orders are completed.
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Conversion Process

Complete the following process to ensure that your current accounting system is in
balance.

To convert your existing work order system

1

In Work Order Options, clear the General Ledger check box to prevent any
postings being made to the general ledger while entering conversion
information.

Enter all open work orders using Work Order Entry.

Enter all transactions recorded for open work orders using Work Order
Transaction Entry. Material costs may not be the same as the original costs.

Print the Work Order Transaction Journal, and perform the update.

Print the Open Work Order Report to verify the information recorded. If
adjustments are necessary, repeat steps 3 and 4.

Print the Work in Process Recap report to verify the information recorded and to
reconcile to the general ledger.

If you are entering material transactions for existing work orders, you can freeze
inventory and perform a physical count and physical count entry without
updating. Updating the Physical Count Variance Register should be performed
only after all material issue transactions are recorded for existing work orders.
Adjustments made during the Physical Count Variance Register update are
recorded as physical adjustments in the Inventory Management Detail
Transaction file. The Inventory Adjustment account in each item's product line is
used to offset the Inventory account posting, unless the General Ledger check
box is cleared in Inventory Management Options during the update process.

Perform the physical inventory process to update the quantity-on-hand
information in inventory. This step should be performed after all material issue
transactions have been recorded for open work orders.

You are ready to begin using your Work Order module.

Getting Started Guide
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